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CHAPTER 1 

INTRODUCTION 

TO ENGINEERING 

DESIGN 

Image courtesy of saVRee.com: https://savree.com/en/encyclopedia/gas-turbine-combustion-turbine 



1.1 Importance of Engineering Design 

 

Definition and Scope of Engineering Design 

Engineering design is a creative process of developing new products, systems, or solutions to meet 

specific needs. It involves problem-solving, creativity, and innovation to produce functional and 

aesthetically pleasing designs. The scope of engineering design ranges from small components to 

complex systems and encompasses various disciplines, including mechanical, electrical, civil, and 

software engineering. 

 

Role of Engineering Design in Product Development 

Engineering design is a cornerstone of product development, serving as the bridge between 

abstract ideas and tangible products. This process involves several critical stages, each contributing 

to the creation of functional, reliable, and manufacturable products that meet user needs and 

industry standards.  

 

Conceptualization 

 

The conceptualization stage is where ideas are born. 

Engineers and designers brainstorm and sketch out 

potential solutions to a given problem or need. This 

phase is highly creative and often involves 

considering multiple design alternatives before 

settling on the most promising concept. 

 

Example: Dyson Vacuum Cleaners 

James Dyson's invention of the first bagless vacuum 

cleaner began with conceptualization. Frustrated with 

his vacuum's declining performance, Dyson 

envisioned a vacuum using cyclonic separation to 

maintain suction. Numerous sketches and conceptual 

models were created before the first prototype was 

built. 

 

 

Figure 1: Dyson Vacuum Cleaner. 



Detailed Design 

 

Once a concept is chosen, the detailed design phase begins. This involves creating precise 3D 

models and detailed drawings that define every aspect of the product. This stage ensures that all 

components fit together correctly and function as intended. 

 

Example: Boeing 787 Dreamliner 

In the development of the Boeing 787 Dreamliner, the detailed design phase was crucial. Engineers 

created comprehensive 3D models of the aircraft, integrating systems such as the electrical wiring, 

fuel lines, and avionics. Detailed drawings specified the materials and dimensions for every 

component, ensuring seamless integration and performance. 

 

Figure 2: Boing 787 Dreamliner. 

 

Prototyping 

 

Prototyping is the process of creating a physical model of the product to evaluate its design, 

functionality, and manufacturability. Prototypes can range from simple mock-ups to fully 

functional models, allowing designers to test and refine their ideas. 

 

Example: SAMSUNG Galaxy Z Fold 

 

Samsung’s development of the Galaxy Z Fold involved creating multiple prototypes to perfect 

the foldable screen technology. Engineers tested various hinge designs, screen materials, and 

folding mechanisms. Each prototype iteration helped Samsung address challenges such as 

screen durability and fold endurance, ultimately leading to a robust and user-friendly final 

product. 

 



 

Testing 

 

Testing is a critical phase where 

prototypes are rigorously evaluated to 

identify any design flaws or performance 

issues. This stage involves various types 

of testing, including stress testing, 

usability testing, and safety testing, to 

ensure the product meets all necessary 

standards and performs reliably under 

expected conditions. 

Example: SpaceX Falcon 9 Rocket 

 

SpaceX’s Falcon 9 rocket underwent extensive testing during its development. Prototypes were 

tested for structural integrity, propulsion efficiency, and reliability under extreme conditions. 

These tests were crucial in identifying potential failure points and refining the design to achieve 

the high reliability needed for space missions. 

 

 

 

Figure 4: SpaceX Falcon Rockets. 

Figure 3: SAMSUNG Galaxy Z Fold Phone. 



Final Production 

 

Once the design has been thoroughly tested and refined, it moves into final production. This stage 

involves scaling up the manufacturing process to produce the product in large quantities while 

maintaining quality and consistency. 

 

Examples of Successful Engineering Designs 

 

GE Haliade-X Wind Turbine: The world's most powerful offshore wind turbine, the Haliade-X 

represents a significant advancement in renewable energy technology. Its design includes a 12 MW 

capacity and a 220-meter rotor, enabling it to produce more energy at lower costs. 

The Vertical Farming Systems by AeroFarms: AeroFarms has developed advanced vertical 

farming systems that use aeroponics to grow crops without soil. These systems can produce large 

quantities of food using less water and space, addressing food security issues in urban areas. 

HoloLens by Microsoft: The HoloLens is a mixed reality headset that overlays digital information 

onto the real world. Its applications range from gaming to industrial design, providing an 

immersive way to interact with digital content and enhancing productivity and creativity. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5: HoloLens Mixed Reality Headset. 



1.2 Overview of SOLIDWORKS 2024 

 

Introduction to SOLIDWORKS as a CAD Software 

 

SOLIDWORKS is a premier computer-aided design (CAD) software extensively utilized in 

engineering and design industries for creating detailed 3D models, performing complex 

simulations, and generating comprehensive documentation for manufacturing and assembly. 

Known for its intuitive user interface and powerful capabilities, SOLIDWORKS facilitates the 

entire design process, from conceptualization to production, making it an indispensable tool for 

both novice and experienced designers. 

 

Key Features and Capabilities of SOLIDWORKS 2024 

 

At the heart of SOLIDWORKS is its robust 3D modeling functionality, which allows designers to 

create precise and complex models with ease. Parametric modeling is one of the core features, 

where dimensions and relationships define the model, enabling automatic updates throughout the 

design whenever changes are made. This ensures consistency and accuracy across all stages of the 

design process. Surface modeling tools in SOLIDWORKS 2024 have been significantly enhanced, 

allowing for the creation of complex shapes and freeform designs that are essential in industries 

such as automotive and consumer products. For those working with sheet metal, the software 

provides specialized tools that simplify the design of flat patterns and bent sheet metal parts, 

integrating manufacturing considerations early in the design process. Additionally, the weldments 

feature offers tools to design welded structures, adding structural members, weld beads, and 

generating cut lists. 

 

 

 

 

 

 

 

 

 
Figure 6: A product designed within SOLIDWORKS Environment. 



SOLIDWORKS is not just about creating static models; it also includes powerful simulation 

capabilities. Finite Element Analysis (FEA) allows users to perform structural, thermal, and 

vibration analyses, helping to evaluate the performance of designs under real-world conditions. 

The Computational Fluid Dynamics (CFD) module facilitates the analysis of fluid flow and heat 

transfer, optimizing the performance of designs involving liquids or gases. Moreover, the motion 

analysis feature simulates the kinematics and dynamics of assemblies, providing insights into how 

parts interact and move, which is crucial for designing mechanical systems. 

 

Documentation is another critical aspect of the design process that SOLIDWORKS addresses 

comprehensively. The software allows users to generate detailed 2D drawings from 3D models, 

including various views, sections, and annotations necessary for manufacturing and assembly. 

Automatically creating and updating Bills of Materials (BOM) is streamlined within 

SOLIDWORKS, listing all components and materials required for a project. Ensuring compliance 

with industry and company standards is made easier using standardized templates and drawing 

formats. 

 

Collaboration is key in modern engineering projects, and SOLIDWORKS offers robust tools for 

team-based design efforts. The SOLIDWORKS Product Data Management (PDM) system helps 

manage design data and control revisions, ensuring that all team members are working with the 

most current information. Integration with the 3DEXPERIENCE platform further enhances 

collaboration by offering cloud-based tools for project management and data sharing, making it 

easier to work with stakeholders across different locations. 

 

Data management in SOLIDWORKS includes features like design history and rollback, which 

track changes and maintain a complete history of the design process. This capability allows 

designers to revert to previous versions if necessary, providing a safety net during the iterative 

design process. Configuration management is also a strong suit, enabling the management of 

multiple configurations of a part or assembly within a single document, which is particularly useful 

for designing product variants. 

 

Benefits of Using SOLIDWORKS in Engineering Design 

 

The benefits of using SOLIDWORKS in engineering design are manifold. Efficiency is 

significantly enhanced through streamlined workflows that integrate various design and simulation 

tools into a single platform, reducing the need to switch between different software. Automation 

features such as design tables and macros save time and reduce errors by automating repetitive 

tasks. Precision in modeling ensures that every detail of the design is accurate, crucial for 

manufacturing and assembly. Advanced simulation tools provide accurate predictions of real-



world performance, allowing designers to make informed decisions early in the design process, 

thus minimizing costly revisions later. 

 

Collaboration is greatly improved with real-time tools and PDM that facilitate teamwork among 

members regardless of their location. Easy sharing of design data with stakeholders, suppliers, and 

customers ensures better communication and feedback, which is essential for iterative 

improvement. The access to cutting-edge tools fosters innovation, enabling engineers to push the 

boundaries of what is possible. The large and active user community provides a wealth of support, 

resources, and inspiration, contributing to a culture of continuous improvement and innovation. 

 

1.3 The Engineering Design Process 

 

Steps in the Engineering Design Process 

 

The engineering design process is a systematic, iterative methodology used by engineers to create 

functional products and processes. It involves several key stages: problem definition, research and 

analysis, conceptual design, detailed design, prototyping and testing, and final design and 

production. This structured approach ensures that designs are thoroughly evaluated and optimized 

before they reach the market. Here’s a more detailed exploration of each stage, with examples to 

illustrate how SOLIDWORKS can be integrated into each step. 

 

Problem Definition 

 

The first step in the engineering design process is to clearly define the problem or need that the 

design will address. This involves understanding the requirements, constraints, and goals of the 

project. It is crucial to gather input from stakeholders to ensure that all aspects of the problem are 

considered. 

 

Example: Automotive Component Design 

For instance, in designing a new automotive component, the problem definition stage would 

involve identifying the specific performance requirements, such as weight reduction, durability, 

and compatibility with existing systems. Engineers would gather data on material properties, 

manufacturing processes, and cost constraints to ensure a comprehensive understanding of the 

project goals. 

 

 



Research and Analysis 

 

Once the problem is defined, the next step is to conduct research and analysis. This involves 

gathering information on existing solutions, technologies, and materials that could be applied to 

the new design. Engineers analyze this information to identify potential approaches and 

innovations. 

 

Example: Medical Device Development 

In the development of a new medical device, engineers would research current technologies and 

materials used in similar devices. They would analyze data on biocompatibility, safety standards, 

and patient needs to determine the most suitable materials and design approaches. Using 

SOLIDWORKS, engineers can create preliminary models and perform initial simulations to 

evaluate different concepts. 

 

 

Conceptual Design 

 

The conceptual design phase is where ideas begin to take shape. Engineers generate multiple 

design concepts and evaluate their feasibility. This stage is highly creative and involves 

brainstorming and sketching out potential solutions. 

 

Example: Consumer Electronics Design 

For a new consumer electronics product, such as a wearable fitness tracker, engineers would 

generate various design concepts focusing on form factor, ergonomics, and functionality. Using 

SOLIDWORKS, they can create 3D sketches and models to visualize these concepts and assess 

their viability. Advanced sketching tools and rapid prototyping capabilities in SOLIDWORKS 

allow engineers to explore different designs quickly and efficiently. 

 

 

Detailed Design 

 

After selecting the most promising concept, the detailed design phase begins. This involves 

creating precise 3D models and detailed drawings that define every aspect of the product. 

Engineers specify dimensions, tolerances, materials, and manufacturing processes. 

 

 



Example: Aerospace Component Design 

In designing an aerospace component, detailed design would involve creating comprehensive 

3D models that include all necessary features and details. Engineers use SOLIDWORKS to 

develop these models, ensuring accuracy and precision. They can also use SOLIDWORKS to 

generate detailed 2D drawings for manufacturing, including specifications for materials, 

dimensions, and assembly instructions. 

 

 

Prototyping and Testing 

 

Prototyping and testing are critical steps where physical models are created to evaluate the design's 

functionality, performance, and manufacturability. Prototypes can range from simple mock-ups to 

fully functional models. 

 

Example: Renewable Energy Systems 

For a new wind turbine blade design, engineers would create prototypes to test aerodynamic 

performance and structural integrity. Using SOLIDWORKS, they can simulate these tests 

virtually before building physical prototypes. Finite Element Analysis (FEA) and Computational 

Fluid Dynamics (CFD) tools in SOLIDWORKS allow engineers to predict how the design will 

perform under real-world conditions, enabling them to refine the design before moving to 

physical testing. 

 

 

Final Design and Production 

 

Once the design has been thoroughly tested and refined, it moves into the final design and 

production phase. This involves preparing the design for mass production, ensuring that all 

components and assemblies can be manufactured efficiently and cost-effectively. 

 

Example: Consumer Product Manufacturing 

In the final production of a new kitchen appliance, engineers use SOLIDWORKS to finalize the 

design, incorporating any changes identified during testing. They generate detailed 

manufacturing documentation, including assembly instructions, Bill of Materials (BOM), and 

quality control procedures. Integration with Product Data Management (PDM) systems in 

SOLIDWORKS ensures that all design data is managed and updated accurately, facilitating 

smooth production processes. 

 

 

How SOLIDWORKS Integrates into Engineering Design Process 



 

SOLIDWORKS plays a crucial role in each stage of the engineering design process. During 

problem definition, SOLIDWORKS tools help document requirements and constraints, providing 

a clear foundation for the project. In the research and analysis phase, SOLIDWORKS enables 

preliminary modeling and simulation, helping engineers evaluate different concepts early on. 

 

In the conceptual design stage, SOLIDWORKS' advanced sketching and modeling tools allow for 

rapid exploration of ideas. Detailed design is where SOLIDWORKS truly excels, providing 

precise 3D modeling and documentation capabilities that ensure accuracy and manufacturability. 

Prototyping and testing are facilitated by SOLIDWORKS’ robust simulation tools, which help 

predict performance and identify potential issues before physical prototypes are built. Finally, in 

the production phase, SOLIDWORKS generates comprehensive documentation and integrates 

with PDM systems to ensure efficient and error-free manufacturing. 

 

Case Study: Using SOLIDWORKS in a Real-World Project 

 

To illustrate the integration of SOLIDWORKS in the engineering design process, consider the 

development of a new electric scooter. The problem definition phase involved identifying the need 

for a lightweight, durable, and energy-efficient scooter suitable for urban commuting. Research 

and analysis focused on existing scooter designs, materials, and battery technologies. 

 

During the conceptual design phase, engineers used SOLIDWORKS to create multiple design 

concepts, evaluating their feasibility in terms of weight, durability, and aesthetics. The most 

promising concept was selected for detailed design, where engineers developed precise 3D models 

and generated detailed drawings for each component. 



Prototyping involved creating physical models to test the scooter’s performance, including battery 

life, structural integrity, and ride comfort. SOLIDWORKS simulations helped refine the design by 

predicting how different materials and design choices would affect performance. After successful 

prototyping and testing, the final 

design was prepared for 

production. Detailed 

manufacturing documentation 

and integration with PDM 

ensured a smooth transition to 

mass production. 

 

 

 

 

 

 

1.4 The Importance of CAD in Modern Engineering 

 

Computer-Aided Design (CAD) has become a fundamental tool in modern engineering, 

transforming how products are conceptualized, designed, and brought to market. The integration 

of CAD systems into engineering workflows has provided numerous advantages, significantly 

enhancing efficiency, reducing costs, and fostering innovation. This section explores the critical 

role of CAD in modern engineering, highlighting its impact on various aspects of the design and 

manufacturing process. 

 

Design Efficiency 

 

One of the most significant benefits of CAD is its ability to streamline the design process. 

Traditional drafting methods were time-consuming and prone to errors, requiring manual revisions 

and extensive physical prototyping. CAD software, such as SOLIDWORKS, enables engineers to 

create detailed and accurate digital models quickly. These models can be easily modified and 

refined, allowing for rapid iteration and optimization. The parametric design capabilities of CAD 

Figure 7: YAMAHA E01 Electric Scooter. 



systems ensure that any changes made to the model are automatically updated across all associated 

drawings and assemblies, maintaining consistency and accuracy throughout the design process. 

 

Cost Reduction 

 

CAD significantly reduces costs associated with product development. Virtual prototyping allows 

engineers to test and validate designs digitally, minimizing the need for physical prototypes. This 

not only saves material costs but also reduces the time required to identify and correct design flaws. 

Advanced simulation tools integrated into CAD software can predict how a product will perform 

under various conditions, allowing engineers to address potential issues before they arise. By 

identifying and resolving problems early in the design phase, companies can avoid costly revisions 

and rework during manufacturing. 

 

Example: Automotive Industry 

In the automotive industry, CAD software is used to design and simulate vehicle components, 

from individual parts to entire systems. Engineers can run crash simulations and aerodynamic 

tests on digital models, reducing the need for expensive physical crash tests and wind tunnel 

experiments. This leads to faster development cycles and significant cost savings. 

 

 

Innovation Facilitation 

 

CAD tools play a crucial role in fostering innovation by providing engineers with the flexibility to 

explore complex geometries and new materials. The ability to visualize and manipulate 3D models 

in a virtual environment allows for more creative and innovative design solutions. Advanced 

features like generative design and topology optimization, available in modern CAD software, 

enable engineers to create lightweight and efficient structures that would be challenging to design 

using traditional methods. 

 

Example: Aerospace Industry 

In aerospace engineering, CAD software has been instrumental in developing advanced 

materials and lightweight structures. Engineers use CAD to design and optimize components 

for strength and weight, enabling the creation of more fuel-efficient aircraft. For example, the 

Boeing 787 Dreamliner’s extensive use of composite materials and advanced aerodynamics was 

made possible through sophisticated CAD modeling and simulation. 

 

 



Collaboration and Communication 

 

CAD software enhances collaboration and communication among team members and 

stakeholders. With the ability to share digital models and design data easily, engineers can work 

together more effectively, regardless of their physical location. Cloud-based CAD platforms, like 

the 3DEXPERIENCE platform integrated with SOLIDWORKS, facilitate real-time collaboration, 

allowing multiple users to access and modify the same design simultaneously. This collaborative 

approach reduces misunderstandings and ensures that everyone involved in the project is on the 

same page. 

 

Example: Construction Industry 

In the construction industry, Building Information Modeling (BIM) tools integrated with CAD 

software enable architects, engineers, and contractors to collaborate on complex building 

projects. By sharing a single digital model, all parties can coordinate their efforts, identify 

potential conflicts, and ensure that the final construction meets the design specifications. 

 

 

Accuracy and Precision 

 

The precision offered by CAD software is unmatched by traditional drafting methods. CAD 

systems allow engineers to create highly detailed and accurate models, ensuring that every 

component fits perfectly within the assembly. This level of precision is crucial in industries where 

tight tolerances are required, such as aerospace, automotive, and medical device manufacturing. 

CAD tools also provide advanced analysis and validation capabilities, helping engineers ensure 

that their designs meet all necessary specifications and standards. 

 

Example: Medical Device Industry 

In the medical device industry, CAD software is used to design implants, prosthetics, and 

surgical instruments with extreme precision. Engineers can create models that match the exact 

anatomical features of patients, ensuring that the final products provide the best possible fit and 

function. This precision is critical for the safety and effectiveness of medical devices. 

 

 

Sustainability and Environmental Impact 

 

CAD software also contributes to sustainability and reducing the environmental impact of product 

development. By enabling virtual testing and optimization, CAD reduces the need for physical 



prototypes, which can be resource-intensive to produce. Advanced simulation tools help engineers 

design products that use less materials and are more energy efficient. Additionally, CAD can 

facilitate the design of products that are easier to disassemble and recycle, supporting the principles 

of a circular economy. 

 

Example: Consumer Electronics 

In the consumer electronics industry, companies use CAD to design products that are not only 

high-performing but also environmentally friendly. For instance, engineers can optimize the 

design of electronic devices to reduce energy consumption and make it easier to recycle at the 

end of their life cycle. 

 

 

1.5 Installing SOLIDWORKS 

 

1. Installation and Setup 

 

Getting started with SOLIDWORKS 2024 involves a few straightforward steps to install and set 

up the software. Here’s a step-by-step guide to help you through the process: 

 

2. System Requirements Check 

 

Before installing SOLIDWORKS 2024, ensure your computer meets the minimum system 

requirements. This includes checking the operating system, processor, RAM, graphics card, and 

hard drive space. 

Visit the SOLIDWORKS official website for detailed system requirements. 

 

3. Download Installation Files 

 

▪ Go to the SOLIDWORKS Customer Portal or your reseller’s website. 

▪ Log in with your credentials or create an account if you don’t have one. 

▪ Navigate to the Downloads section and select SOLIDWORKS 2024. 

▪ Download the installation manager, which will guide you through the rest of the process. 

 



4. Run the Installation Manager 

 

Open the downloaded installation manager. 

Choose the type of installation: Individual, Administrative Image, or Server Products. 

For most users, the Individual option is appropriate. 

 

5. Enter Serial Numbers 

 

You will be prompted to enter your SOLIDWORKS serial numbers. These are provided by your 

reseller or found in your purchase confirmation email. 

Enter the serial numbers for SOLIDWORKS and any additional products like Simulation, 

Composer, or Electrical if you have them. 

 

6. Select Products to Install 

 

The installation manager will display a list of products associated with your serial numbers. 

Select the products you wish to install and click Next. 

Choose Installation Location 

 

Select the destination folder for the SOLIDWORKS installation. The default location is usually 

appropriate, but you can change it if needed. 

Ensure there is enough disk space available. 

 

7. Download and Install 

 

The installation manager will download the necessary files and install SOLIDWORKS. 

This process can take some time, depending on your internet speed and computer performance. 

 

 



 

Figure 8: SOLIDWORKS Installation Screen. 

8. Activation 

 

After installation, launch SOLIDWORKS. 

You will be prompted to activate the software. Follow the on-screen instructions to complete the 

activation process. 

You can choose online or offline activation, depending on your internet access. 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 1 Practice Questions 

 

Definition and Scope of Engineering Design 

1. What is engineering design? 

A) A scientific method for testing hypotheses. 

B) A creative process of developing new products, systems, or solutions to meet specific needs. 

C) A process of maintaining and repairing existing products. 

D) A method for financial planning in engineering projects. 

 

2. Which disciplines are encompassed by engineering design? 

A) Mechanical, electrical, and civil engineering only. 

B) Software engineering only. 

C) Mechanical, electrical, civil, and software engineering. 

D) Chemical and agricultural engineering only. 

 

Role of Engineering Design in Product Development 

 

3. How does engineering design serve as a bridge in product development? 

A) By providing financial support for projects. 

B) By converting abstract ideas into tangible products. 

C) By managing marketing strategies. 

D) By ensuring products are recycled correctly. 

 

4. Which of the following is NOT a critical stage of the engineering design process? 

A) Conceptualization 

B) Marketing analysis 

C) Detailed design 

D) Testing 



Conceptualization 

5. What happens during the conceptualization stage? 

A) Detailed manufacturing plans are created. 

B) Engineers and designers brainstorm and sketch potential solutions. 

C) The product is marketed to consumers. 

D) Financial feasibility is assessed. 

 

6. Which product is an example of a strong conceptualization phase? 

A) Dyson Vacuum Cleaners 

B) Boeing 747 

C) Ford Model T 

D) iPhone 12 

 

Detailed Design 

 

7. What activities are involved in the detailed design phase? 

A) Conducting market research 

B) Creating precise 3D models and detailed drawings 

C) Launching the product to the market 

D) Managing customer feedback 

 

8. How did detailed design contribute to the Boeing 787 Dreamliner development? 

A) By creating comprehensive 3D models integrating various systems. 

B) By testing the marketing strategies for the aircraft. 

C) By producing the final assembly line. 

D) By developing the brand identity for Boeing. 

 

 



Prototyping 

 

9. Why is prototyping essential in the engineering design process? 

A) It allows for the final product to be marketed. 

B) It helps in evaluating the design, functionality, and manufacturability. 

C) It is necessary for regulatory approval. 

D) It ensures the product is environmentally friendly. 

 

Testing 

 

10. What types of testing are typically involved in the engineering design process? 

A) Market testing and financial testing 

B) Stress testing, usability testing, and safety testing 

C) Employee satisfaction testing 

D) Legal compliance testing 

 

Final Production 

 

11. What is a key consideration during the final production stage? 

A) Evaluating initial sketches and ideas 

B) Ensuring quality and consistency in manufacturing 

C) Conducting market surveys 

D) Drafting the initial design specifications 

 

 

 

 

 



Examples of Successful Engineering Designs 

 

12. Which engineering design principle contributed to the success of the GE Haliade-X Wind 

Turbine? 

A) Use of renewable energy technology 

B) Advanced marketing strategies 

C) Financial planning 

D) Customer satisfaction surveys 

 

Integration with SOLIDWORKS 

 

13. How can SOLIDWORKS be utilized in the conceptualization phase of engineering 

design? 

A) For creating initial sketches and 3D models 

B) For conducting market research 

C) For managing production schedules 

D) For drafting financial reports 

 

14. How does SOLIDWORKS help in the detailed design and documentation process? 

A) By creating advertisements for the product 

B) By providing precise 3D modeling and documentation capabilities 

C) By handling customer service inquiries 

D) By managing company finances 

 

 

 

 

 

 



Importance of Engineering Design 

 

15. Why is engineering design considered a cornerstone of product development? 

A) It ensures effective marketing strategies. 

B) It helps in converting abstract ideas into tangible products. 

C) It manages the financial aspects of product development. 

D) It handles customer feedback and support. 

 

16. What role does creativity play in the engineering design process? 

A) It is not significant and rarely used. 

B) It is essential for problem-solving and innovation. 

C) It is primarily used in the marketing phase. 

D) It is only relevant during the final production stage. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 1 Answer Sheet 

 

1. B 

2. C 

3. B 

4. B 

5. B 

6. A 

7. B 

8. A 

9. B 

10. B 

11. B 

12. A 

13. A 

14. B 

15. B 

16. B 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



CHAPTER 2  

TWO-

DIMENSIONAL 

SKETCHING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



2.1 Introduction to Sketching in SolidWorks 

 

Sketching in SolidWorks is the cornerstone of the entire 3D modeling process. Whether you’re 

designing a simple bracket or a complex assembly, every part begins with a well-constructed 2D 

sketch. Think of a 2D sketch as the blueprint or the skeleton of your final design—it’s where you 

establish the shapes, dimensions, and relationships that form the foundation of your 3D model. 

 

Why is Sketching Important? 

SolidWorks is a parametric modeling tool, meaning it relies on sketches and constraints to define 

geometry. The key to successful 3D modeling is creating precise, accurate, and flexible sketches. 

Here’s why sketching is so critical: 

Foundation for 3D Shapes: A 2D sketch defines the profiles that are extruded, revolved, or lofted 

to create 3D geometry. 

Control and Precision: Well-defined sketches ensure that changes in one part of the design 

propagate predictably through the model. 

Efficiency: A properly constrained sketch reduces errors and simplifies modifications later in the 

design process. 

For beginners, mastering the sketch environment is like learning the grammar of a new language. 

It provides the building blocks for creating functional and aesthetically pleasing designs. 

 

Figure 9: Product Sketch Illustration. 

 



What Is the Sketch Environment? 

The sketch environment in SolidWorks is a workspace designed specifically for creating and 

editing 2D sketches. It is activated when you begin a new sketch on a selected plane or planar face. 

Let’s break this environment down into its key components: 

 

Planes 

Planes are flat, infinite surfaces where sketches are created. Think of them as sheets of paper 

floating in 3D space. SolidWorks comes with three default planes: 

 

Front Plane: Represents a front-facing view. 

Top Plane: Acts as a bird’s-eye view. 

Right Plane: Represents a side view. 

You can select any of these planes as the foundation for your sketch. Additionally, custom planes 

can be created if your design requires sketches at specific angles or positions. 

 

Figure 10: Default Planes in SolidWorks. 

 

 

 



Sketch Toolbar 

The Sketch toolbar provides access to all the tools you need to create geometry, such as lines, 

circles, rectangles, arcs, and splines. It also includes tools for applying dimensions, constraints, 

and relations to your sketch entities. 

 

 

Figure 11: The Sketch Toolbar. 

 

Graphics Area 

This is the main workspace where your sketch appears. When you enter the sketch environment, 

the selected plane is highlighted, and you can begin drawing directly on it. A grid may appear, 

depending on your settings, to assist with alignment. 

 

Feature Manager Tree 

The Feature Manager tree, located on the left-hand side of the screen, lists all the planes, sketches, 

and features in your model. It helps you organize and navigate your design process. 

 

Figure 12: Graphics Area and Features Tree. 



Property Manager 

When you select a sketch tool, the Property Manager appears, allowing you to customize the tool’s 

settings, such as line type, dimensions, or relations. 

 

Heads-Up Toolbar 

This floating toolbar provides quick access to commonly used commands like zoom, rotate, and 

view orientation. It ensures that you don’t have to navigate away from your workspace to perform 

basic operations. 

 

 

Figure 13: Heads-Up Toolbar. 

 

 

 

 

 

 

 

 

 

 



2.2 Creating Basic Geometric Shapes 

 

In SolidWorks, creating basic geometric shapes is a foundational skill that enables users to build 

more complex models. The software provides a variety of tools for drawing fundamental shapes 

such as lines, circles, rectangles, arcs, and splines. These shapes serve as the building blocks of 

your sketches, which can later be used to create 3D features. 

 

Let’s explore these tools in detail and understand how to use them effectively. 

 

2.2.1 Drawing a Line 

The Line Tool is one of the most versatile tools in SolidWorks and is often used to create edges, 

boundaries, and construction geometry. Most SolidWorks designs start with using the line tool in 

their basic sketch before turning into a sophisticated three-dimensional design. 

Drawing usually happens within the sketch environment only. Entering the sketching 

environment can be achieved by following the steps detailed here: 

 

1. Open SolidWorks. 

2. From File choose New. 

 

 
 

 

 

 

 

 

 

 

 

 

 



3. Select Part 

 

 
 

4. View the sketching plane needed. 

 

 
 

Now you are ready to start sketching. 

Steps to Draw a Line: 

1. Activate the Tool: 

Click the Line Tool Sketch toolbar, or press L on your keyboard. 

 



2. Select the plane you want to draw the line on 

 
3. Start the Line: 

Click anywhere on the active sketch plane to set the starting point. 

 

4. Define the Line: 

Move the mouse to adjust the line's length and direction. Click again to set the endpoint. 

 

After defining the end point of the line, you will notice a parameters dialogue to the left of the 

screen for the line length and angle. Input the exact length you need for the line and the line 

angle with the horizon. For a straight horizontal line, the angle is 0o. 

 

5. Exit the Tool: 



Press Esc to exit the Line Tool, or press L again to start a new line. 

 

Tips for Drawing Lines 

 

Constrain the Direction: Hold down the Shift key while drawing to lock the line's direction 

horizontally, vertically, or at 45° increments. 

 

Snap to Geometry: Pay attention to the yellow inference lines or dots that appear while 

sketching. These indicate alignment with existing geometry, such as other lines, points, or the 

origin. 

 

Chain Mode: After finishing a line, you can immediately start another connected line without 

exiting the tool. Simply click to set the next start and endpoint. 

 

 

2.2.2 Drawing a Rectangle 

Rectangles are commonly used to define the boundaries of parts, profiles, or slots. SolidWorks 

provides multiple rectangle types to suit different design needs. 

 

Types of Rectangles and Their Use Cases: 

 

1. Corner Rectangle (Default): 

Ideal for creating rectangles where you define two opposite corners. 

Commonly used for basic rectangular profiles. 

 

2. Center Rectangle: 

Useful for symmetric designs where you want to define the center of the rectangle first. 

 

 

3. 3-Point Rectangle: 

Allows you to create rectangles at an angle by defining three points: one corner, the adjacent 

corner, and the direction. 

 

 



4. Parallelogram (Optional): 

Designed for sketches where you need slanted, parallelogram-like geometry. 

 

Drawing a Corner Rectangle 

1. Click the Rectangle Tool from the Sketch toolbar. 

2. From the drop-down menu, select Corner Rectangle (if not already selected by default). 

 

 
 

3. Click to set the first corner point, then drag to define the opposite corner. Click again to 

complete the rectangle. 

 

Tips for Drawing Rectangles 

 

Automatic Constraints: SolidWorks automatically adds horizontal and vertical constraints to 

the rectangle’s sides for stability. 

Dimensions: After creating the rectangle, use the Smart Dimension Tool to add dimensions and 

define the rectangle’s size. 

Dynamic Feedback: As you draw, notice the dimensions appear dynamically next to your 

cursor, showing the rectangle's width and height. 

 

 

 

 



2.2.3 Drawing a Circle 

Circles are essential for creating holes, round profiles, and other circular features in designs. 

 

Steps to Draw a Circle 

1. Select the Circle Tool from the Sketch toolbar, or press C on your keyboard. 

 

 
 

2. Click anywhere on the sketch plane to define the circle’s center point. 

 

 
 

3. Drag the mouse outward to set the size of the circle and click again to finalize it. 

 

4. On the left dialogue of the screen input the value of radius for the sketched circle then 

press Enter. 



 

 
 

Tips for Drawing Circles 

 

Concentric Circles: To create a circle concentric with an existing one, hover near the center 

of the first circle. A yellow concentric symbol will appear. 

 

Dimensions: Use the Smart Dimension Tool to define the circle’s diameter or radius. Right-

click the circle to toggle between diameter and radius dimensions. 

 

Snapping to Geometry: Circles can snap to the origin, edges, or midpoints of other geometry 

for precise alignment. 

 

 

2.2.4 Creating Arcs 

Arcs are partial circles often used for rounded edges, slots, or profiles. SolidWorks provides 

multiple types of arcs for flexibility. 

 

Types of Arcs 

 

3-Point Arc: 

Click to set the start point, then the endpoint, and drag to define the curvature. 

 

CenterPoint Arc: 

Define the center point first, then click to set the start and endpoint. 

 

 



Tangent Arc: 

Automatically snaps the arc tangentially to existing geometry. 

 

Steps to Draw a 3-Point Arc 

1. Click the Arc Tool from the Sketch toolbar and select 3-Point Arc. 

 

 
 

2. Click the first point to set the starting location. 

 

 
 

3. Click the second point to define the arc's endpoint. 

 

 
 

4. Drag to adjust the curvature. 

 

 



5. Input the parameters needed for the arc such as radius and angle in the dialog to the left 

of the screen then hit the green tick to finalize. 

 

 
 

Tips for Drawing Arcs 

 

Use Tangency: SolidWorks automatically adds a tangency constraint if the arc connects to an 

existing line or circle. 

Dynamic Adjustments: After drawing, adjust the arc’s curvature by dragging its midpoint or 

end points. 

 
 

2.3 Sketch Constraints and Relations 

 

When creating sketches in SolidWorks, understanding and applying constraints and relations is 

essential to ensure your design behaves as intended during modifications. These tools control how 

sketch entities interact with one another and help maintain the design intent, even when dimensions 

or shapes are changed. 

 

What Are Constraints? 

Constraints, also referred to as geometric relations, define the behavior and relationship between 

sketch entities. These are applied automatically by SolidWorks in some cases as you sketch, but 

they can also be manually added to enhance precision and ensure proper control over your 

geometry. 

 

 



Examples of Constraints 

Horizontal or Vertical Lines: A line can be constrained to remain perfectly horizontal or vertical. 

 

Concentric Circles: Two circles can share the same center point. 

 

 

Tangency: A line or arc can be constrained to touch a circle or another arc at a single point, 

maintaining smoothness at the intersection. 

 

Constraints are especially useful for ensuring that sketches remain parametric, meaning they adjust 

predictably when dimensions or other parts of the sketch are changed. 

 



How to Apply Constraints 

SolidWorks offers a simple and intuitive way to apply constraints manually to sketch entities. 

Follow these steps to apply constraints: 

 

1. Select Entities: 

Click on one or more sketch entities, such as lines, arcs, or points. The entities can be selected by 

clicking directly on them or by dragging a selection box around them. 

 

2. Open the Add Relations Menu: 

When entities are selected, the Add Relations section appears in the left-hand Property Manager. 

This menu provides a list of applicable relations based on the selected entities. 

 



 

3. Choose the Desired Relation. 

 

4. Check the Status: 

After applying constraints, SolidWorks displays a green icon near the related geometry, 

indicating the applied relation. 

 

 

Types of Common Constraints and Their Uses 

1. Coincident 

Ensures two points overlap or that a point lies on a line, arc, or circle. 

2. Collinear 

Ensures two or more lines lie on the same infinite line. 

3. Parallel 

Ensures two lines never intersect, regardless of length. 

4. Perpendicular 

Ensures two lines intersect at a 90° angle. 

5. Tangent 

Ensures a line or arc touches a curve or circle at exactly one point, creating a smooth transition. 

6. Equal 

Forces two entities, such as lines, arcs, or circles, to have the same length or radius. 

7. Concentric 

Ensures two circles or arcs share the same center point. 

8. Horizontal or Vertical 

Forces lines to align perfectly along the horizontal or vertical axis. 

 



 

Figure 14: Common SolidWorks Constraints. 

 

Automatic Constraints in SolidWorks 

While sketching, SolidWorks automatically applies some constraints to improve efficiency. For 

example: 

 

When drawing a line, moving the cursor horizontally or vertically causes SolidWorks to 

automatically apply a Horizontal or Vertical constraint (indicated by a yellow icon near the line). 

Hovering over an endpoint of an existing line before starting a new one creates a Coincident 

constraint automatically. 

 

Tips to Work with Automatic Constraints 

 

• Pay attention to the yellow inference lines or symbols that appear as you sketch. These 

suggest constraints that will be applied automatically. 

• If an automatic constraint isn't desired, press Ctrl while sketching to temporarily disable 

it. 

 

Managing and Editing Constraints 

All constraints in SolidWorks are visible in the Feature Manager Design Tree and directly on the 

sketch geometry.  

 

 



To manage or edit these: 

• View Constraints: 

Hover over a sketch entity to see its existing constraints, represented by small icons. 

• Delete Constraints: 

Right-click a constraint icon and select Delete to remove it. 

• Modify Constraints: 

Select a different relation from the Add Relations menu to change the behavior of the geometry. 

 

Fully Defined Sketches 

A well-constrained sketch is a fully defined sketch, meaning every entity has specific dimensions 

or relations that control its size, position, and orientation. Fully defined sketches are marked in 

black in SolidWorks, while underdefined sketches appear in blue. 

Why Fully Define Sketches? 

• Prevents unintended changes when editing. 

• Ensures the model updates predictably when dimensions are modified. 

• Avoids errors during 3D feature creation. 

 

 

 

 

 

 

 

 

 

 

 

 

 



2.4 Dimensioning the Sketch 

 

Dimensioning is a critical step in sketching within SolidWorks as it specifies the exact size, 

position, and angles of your sketch entities. Proper dimensioning transforms a sketch from under-

defined to fully defined, ensuring it behaves predictably and aligns with your design intent. 

 

Why Dimensioning Is Important 

Dimensions provide precise control over your sketch geometry. Without dimensions, your sketch 

is ambiguous and may not behave as expected during further modeling steps, such as extrusion or 

revolved features. By dimensioning, you can: 

 

• Specify exact sizes of lines, circles, arcs, or other entities. 

• Control the position of sketch entities relative to each other or the origin. 

• Define angles between lines or between curves and reference geometry. 

• Ensure your design adheres to engineering requirements. 

 

Types of Dimensions in SolidWorks 

 

1. Linear Dimensions: 

• Measure the distance between two points, such as the endpoints of a line. 

• Useful for defining the length of edges or the spacing between entities. 

 

2. Radial and Diameter Dimensions: 

• Measure the radius or diameter of circular entities like circles and arcs. 

• Essential for defining holes, fillets, or rounded features. 

 

3. Angular Dimensions: 

• Measure the angle between two lines or the included angle of an arc. 

• Useful for sketches involving inclined lines or rotational features. 

 

4. Ordinate Dimensions: 

• Define the position of entities in relation to a reference point. 

• Often used in complex sketches to maintain positional control. 



How to Add Dimensions 

SolidWorks makes dimensioning intuitive with the Smart Dimension Tool, which allows you to 

add various dimensions based on the entities you select. Here’s how to use it: 

 

1. Activate the Tool: 

Select the Smart Dimension tool from the Sketch toolbar, or press the keyboard shortcut D. 

 

2. Select an Entity: 

• Single Entity: 

Click on a line to set its length, a circle to set its diameter, or an arc to define its radius. 

 

• Two Entities: 

Click on two points, lines, or circles to define a distance, angle, or positional relationship 

between them. 

 

3. Position the Dimension: 

Move the mouse to drag the dimension to the desired location. SolidWorks automatically 

provides a preview of the dimension. 

Click again to place the dimension. The numeric value is now editable. 



 

 

4. Adjust Dimension Values: 

After placing the dimension, double-click the value to edit it. Enter the desired number and press 

Enter to finalize. 

 

Dimensioning Techniques 

 

Dimensioning a Line: 

1. Select the Smart Dimension tool. 

2. Click on the line to define its length. 

3. Drag the dimension line outward and click to place the dimension. 

 

 

Dimensioning a Circle: 

1. Select the Smart Dimension tool. 

2. Click on the circle to set its diameter or radius (default is diameter). 

3. Position the dimension text by dragging outward and clicking. 



 

Dimensioning Between Two Entities: 

1. Select two entities (e.g., two lines or points). 

2. If the entities are parallel, SolidWorks will measure the perpendicular distance. 

3. For non-parallel lines, an angle dimension will be provided by default. 

 

Dimensioning to the Origin: 

Click a sketch entity (e.g., a line or circle) and then click the Origin to dimension its position 

relative to the sketch's starting point. 

 

 

 



Defining vs. Over-Defining Sketches 

In SolidWorks, the status of your sketch is visually indicated by the color of its geometry: 

 

1. Black Geometry: Fully Defined 

All dimensions and constraints are applied. The sketch's size and position are completely fixed. 

Example: A rectangle where all four sides have dimensions, and its position relative to the origin 

is defined. 

 

2. Blue Geometry: Under-Defined 

Some entities still lack dimensions or constraints, allowing them to move or resize freely. 

Example: A circle without a specified diameter or location. 

 

3. Red Geometry: Over-Defined 

Conflicting dimensions or constraints are applied, resulting in an over-constrained sketch. 

Example: A line constrained to two conflicting lengths. 

 

Avoiding Over-Defined Sketches 

Double-check existing dimensions and constraints before adding new ones. If an error occurs, 

remove unnecessary or redundant constraints using the Delete key or right-clicking on the 

dimension/constraint and selecting Delete. 

 

Tips for Effective Dimensioning 

 

Use the Origin as a Reference: 

Start by positioning key sketch entities relative to the origin. This ensures that your 

sketch is anchored in 3D space. 

 

Dimension Symmetrically: 

When working on symmetrical designs, dimension only one side and use symmetry 

constraints to mirror the other. 

 

Avoid Over-Defining: 

Use only the minimum number of dimensions needed to fully define the sketch. 

 



2.5 Editing and Modifying Sketches 

 

Sketches in SolidWorks are highly versatile, allowing you to make adjustments dynamically even 

after they have been created. Editing and modifying sketches efficiently is essential for creating 

complex designs while maintaining design intent and adaptability. SolidWorks offers a suite of 

tools specifically designed for trimming, extending, mirroring, and offsetting sketch entities. This 

section will provide detailed guidance on how to utilize these tools effectively. 

 

Trimming and Extending Sketch Entities 

Sketches often contain excess or incomplete geometry, especially when working with intersecting 

lines, arcs, or curves. The Trim and Extend tools help refine such sketches by removing 

unnecessary sections or completing entities to meet intersections. 

 

Trimming Entities 

The Trim Entities tool allows you to remove parts of sketch entities that extend beyond or 

intersect with other entities. 

1. Select the Trim Entities tool from the Sketch toolbar. 

 

2. Select the Trim Method: 

• Power Trim: Click and drag your mouse cursor across the portion of the entity you wish 

to remove. This method provides a dynamic and intuitive way to trim geometry. 

• Trim to Closest: Click on the section of an entity to trim it back to the nearest intersecting 

entity. 



 

 

3. Trim the Entities: 

Hover over the part of the sketch you want to trim, and SolidWorks will highlight it. Click to 

remove it. 

 

4. Exit Trimming: 

Press Esc to exit the tool. 

Tips for Trimming 

Use Ctrl+Z to undo accidental trims. 

Watch for the yellow preview that indicates the section to be trimmed. 

 

 



Extending Entities 

The Extend Entities tool is used to extend sketch entities (e.g., lines or arcs) to meet another 

sketch entity. 

 

1. Select the Extend Entities tool from the Sketch toolbar. 

 

2. Select the Entity to Extend: 

Hover over the endpoint of the entity you wish to extend. SolidWorks highlights the preview 

extension path. 

 

3. Extend: 

Click to extend the entity until it meets the next sketch entity. 

 

 

 



Offsetting and Mirroring Sketch Entities 

Offsetting and mirroring are powerful tools for creating repetitive or symmetrical geometry, 

reducing the need for redundant sketching. 

 

Offsetting Entities 

The Offset Entities tool allows you to create parallel copies of existing sketch geometry. These 

offsets can be created at a specified distance and can either follow the original direction or be 

reversed. 

 

1. Activate the Tool: 

Select the Offset Entities tool from the Sketch toolbar. 

 

2. Select the Entities: 

Click on the line, curve, or set of sketch entities you wish to offset. 

 

3. Specify the Offset Distance: 

Enter the desired offset distance in the Property Manager. 

 

4. Choose the Direction: 

Use the directional arrows to control whether the offset is inward or outward. 

 

5. Create the Offset: 

Click OK to finalize the offset. 

Tips  

 

• Use the Bi-Directional Offset option to create offsets on both sides of the selected 

entity. 

• Maintain relationships between the original and offset geometry for better control 

during design modifications. 

 

 



Mirroring Entities 

The Mirror tool duplicates selected sketch entities across a designated centerline, creating 

symmetrical geometry. 

 

1. Select the Mirror Entities tool from the Sketch toolbar. 

 

2. Select the Geometry to Mirror: 

Click on the lines, arcs, or other sketch entities you wish to mirror. For selecting more than one 

entity hold the ctrl key while selecting.  

 

3. Define the Mirror Line: 

Click on the sketch entity that serves as the centerline (e.g., a vertical or horizontal line). If there 

is no mirror line created by drawing a line at the mirroring axis of your choice. Delete the line 

after finishing the mirroring process. 



 

4. Preview and Finalize: 

SolidWorks displays a preview of the mirrored geometry. Click OK to complete the mirroring 

operation. Notice that the selected entities and mirroring axis are shown to the left dialogue and 

can be adjusted before confirming the mirroring. 

 

 

Tips  

 

• Ensure that the mirror line is properly constrained and positioned to maintain 

symmetry. 

• Use construction lines (dashed lines) as mirror lines for better organization. 

 

 

 

 



Example: Sketching a Mechanical Component 

Create the base sketch for a mounting bracket following the dimensions provided. 

 
 

 

Solution 

1. Start with a Corner Rectangle to define the main body. Define the length and the width to be 

50 mm each using smart dimensions tool. 



 

 

 
 

2. Add the central circles by drawing 25 mm line on the horizontal axis and 25 mm on the 

vertical axis. Start drawing the circle and type in the diameter of 30 mm then press Enter. 

 



3. Draw a circle at each corner 5mm inward from the vertical edge of the bracket and 5 mm 

away from the horizontal edge. Repeat this process for the remaining three holes. Or use the 

mirroring feature to mirror two holes into four holes. 

 
 

 



 
 

4. Use the Smart Dimension tool to write dimensions into the sketch. 

 
5. Use the Trim Tool to cut unnecessary parts if needed. 



Chapter 2 Practice Questions 

 

 

Section 1: Multiple Choice Questions  

 

1. Which of the following is NOT a default plane in SolidWorks? 

A. Front Plane 

B. Top Plane 

C. Right Plane 

D. Bottom Plane 

 

2. What happens when a sketch entity is over-defined in SolidWorks? 

A. It turns blue. 

B. It turns black. 

C. It turns red. 

D. It disappears from the sketch. 

 

3. Which tool allows you to create parallel copies of an existing sketch entity? 

A. Mirror Entities 

B. Offset Entities 

C. Extend Entities 

D. Trim Entities 

 

4. What is the main purpose of the "Smart Dimension" tool? 

A. To create sketch entities. 

B. To trim unwanted parts of a sketch. 

C. To define the size and position of sketch entities. 

D. To apply constraints between entities. 



 

5. Which relation ensures that two circles share the same center point? 

A. Tangent 

B. Concentric 

C. Coincident 

D. Equal 

 

6. What does the color blue indicate in a SolidWorks sketch? 

A. The geometry is over-defined. 

B. The geometry is fully defined. 

C. The geometry is under-defined. 

D. The geometry is unsaved. 

 

7. Which of the following tools can be used to create a rectangle in SolidWorks? 

A. Corner Rectangle 

B. Center Rectangle 

C. 3-Point Rectangle 

D. All of the above 

 

8. What does the "Trim Entities" tool do? 

A. Creates a mirrored copy of the selected geometry. 

B. Deletes unwanted parts of lines or curves. 

C. Moves sketch entities to a new location. 

D. Makes a sketch entity tangent to another. 

 

 

 

 



9. Which tool would you use to create a horizontal line across the center of your sketch? 

A. Line Tool 

B. Centerline Tool 

C. Mirror Entities 

D. Spline Tool 

 

 

10. What type of rectangle requires you to set its center point first? 

A. Corner Rectangle 

B. Center Rectangle 

C. 3-Point Rectangle 

D. Tangent Rectangle 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Section 2: Design Practice Questions 

 

Design Task 1: Simple Frame 

Design a rectangular frame with the following requirements: 

 

Outer dimensions : 200 mm x 150 mm. 

Inner dimensions : 180 mm x 130 mm. 

 

 

Design Task 2: Circular Plate with Holes 

Create a circular plate with the following specifications: 

 

Outer circle diameter: 150 mm. 

Add four smaller circles (diameter 10 mm each) evenly spaced around the outer circle. Use the 

"Smart Dimension" tool to position the smaller circles at equal distances from the plate’s center. 

Fully define the sketch with dimensions and relations. 



 

 

Design Task 3: Mechanical Bracket Sketch 

Sketch the base profile for a mounting bracket: Start with a rectangle measuring 100 mm x 60 

mm. Add two circular holes (diameter 15 mm) at the top corners of the rectangle. Ensure the 

circles are concentric with the top corners. Trim excess geometry to leave a smooth profile. Fully 

define the sketch. 

 

Design Task 4: Mirrored Sketch 

Create a symmetrical design for a keychain: Start with a base rectangle of size 80 mm x 40 mm. 

Draw a circle with a diameter of 10 mm near one corner of the rectangle. Use a centerline to 

divide the rectangle into two equal halves. Mirror the circle to the opposite side of the rectangle. 

Fully define the sketch and include all necessary dimensions. 

 

 

 

 



Chapter 2 Answer Sheet 

 

1. D 

2. C 

3. B 

4. C 

5. B 

6. C 

7. D 

8. B 

9. B 

10. B 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



CHAPTER 3  

PARTS AND 

FEATURES 
 

 

 

 

 

 



3.1 Introduction to Parts and Features 

 

SolidWorks is centered around the concept of parts, which are individual components that can be 

combined to create complex assemblies. A part is essentially a single 3D object, designed by 

combining various features. Features are the tools used to shape parts by either adding or removing 

material. For instance, extrusions are used to extend 2D sketches into 3D objects, cuts remove 

material to create spaces or holes, and revolutions rotate 2D sketches around an axis to form 

cylindrical or spherical shapes. 

 

Every feature begins with a 2D sketch, making sketches the foundation of all parts. The shapes 

drawn in a sketch, such as rectangles, circles, or splines, act as profiles that SolidWorks uses to 

generate 3D geometry. Fully defining these sketches with dimensions and constraints ensures the 

resulting features behave predictably and meet design requirements. For example, a rectangular 

sketch can be extruded into a block, a circular sketch can create a hole through an extruded cut, 

and a semicircular sketch can be revolved to form a sphere. 

 

Figure 15: 2D to 3D geometry illustration. 

Parts in SolidWorks are built by combining two main types of features: base features and secondary 

features. The base feature such as an extrusion, which forms the core of the part. Secondary 

features modify or add details to the base feature, such as fillets to round edges or cuts to remove 

material. This layered approach to part creation allows for precise control and easy modification. 

 

One of the key advantages of feature-based modeling is its parametric nature. Features are driven 

by parameters, such as dimensions and constraints, which can be adjusted at any time. These 

changes automatically update the part and any dependent features, ensuring the design remains 

consistent. The feature-based approach also captures design intent, allowing relationships like 

concentricity or symmetry to remain intact even when the geometry is edited. Additionally, the 

Feature Manager Design Tree organizes all features in a part, making it easy to modify or reorder 

them. 

 



The workflow for creating a part in SolidWorks begins with selecting a sketching plane and 

creating a 2D profile. This profile is then transformed into a 3D feature using tools like Extrude or 

Revolve. Secondary features can then be added to refine the part, such as chamfers, fillets, or 

additional cuts. This process allows for iterative development, where the part evolves through the 

addition and refinement of features. 

 

For example, creating a simple block with a cylindrical hole demonstrates the relationship between 

sketches and features. First, a rectangle is drawn on the Front Plane and dimensioned to define its 

size. This sketch is then extruded to form a solid block. Next, a circle is sketched on the top face 

of the block, dimensioned to specify its diameter, and then cut using the Extruded Cut tool to create 

the hole. This process illustrates how sketches and features work together to build precise parts. 

 

Parts are not standalone; they are often combined with other parts to create assemblies. Mastering 

the creation of robust and accurate parts is essential for building larger systems, which will be 

explored in later chapters. Understanding parts and features lays the foundation for 3D modeling 

in SolidWorks and equips you with the skills to create components with precision and flexibility 

for any design project. 

 

3.2 Creating a Basic Part 

 

Creating a basic part in SolidWorks is the first step toward mastering 3D modeling. Parts are built 

by transforming 2D sketches into 3D shapes using features such as extrusions, revolutions, and 

cuts. In this section, we’ll guide you through the process of creating your first basic part, 

introducing key tools and workflows. 

 

Steps to Create a Basic Part 

Step 1: Start a New Part File 

1. Open SolidWorks and click on File > New > Part. This creates a blank canvas where you can 

design your part. 

 



 
 

 
 

2. Once inside the new part environment, the first task is to select Sketch and then select a plane 

for sketching.  

3. Click on one of these planes in the Feature Manager Design Tree to activate it as your 

sketching surface. 

Step 2: Create a Sketch 

1. After selecting the plane, SolidWorks enters the sketching environment. 

2. Use the sketching tools from the Sketch Toolbar to draw a 2D shape.  

3. Add dimensions to fully define the sketch. Use the Smart Dimension Tool to specify the size 

and position of the sketch entities. 

4. Apply constraints (like horizontal, vertical, or concentric relations) to ensure the sketch 

behaves predictably when modified. 



 

 

Step 3: Add a Feature 

Once the 2D sketch is complete, it’s time to transform it into a 3D object by adding a feature. The 

Extrude Boss/Base tool is one of the most commonly used tools for this purpose. 

 

1. Click on Features > Extruded Boss/Base from the Command Manager. 

 

 
 

2. In the Property Manager, define the extrusion settings: 

• Depth: Specify how far the sketch will extend in the third dimension (e.g., 50 mm). 

• Direction: Choose whether the extrusion extends forward, backward, or 

symmetrically in both directions. 

• Draft Angle (optional): Add a taper to the extrusion if needed. 

 



 

 

3. Preview the 3D shape in the graphics window. Adjust parameters as necessary. 

4. Click OK to finalize the feature. 

 

 

 

Step 4: Modify the Part 

Once the first feature is created, additional features can be added to refine the part. Use tools like 

Extruded Cut to remove material (e.g., create holes or slots). Add fillets or chamfers to smooth or 

taper edges. To modify the part further, right-click on the feature in the Feature Manager Design 

Tree and select Edit Feature or Edit Sketch. 



 

 

3.3 Understanding Features 

 

Features are the building blocks of SolidWorks parts. They define how the material is added, 

removed, or modified. Below are some of the most commonly used features: 

 

3.3.1 Boss/Base Features 

These features add material to your part. 

 

Extrude Boss/Base 

The Extrude Boss/Base tool is one of the most fundamental and versatile features in SolidWorks. 

It is used to transform a 2D sketch into a 3D solid shape by extruding the sketch along a straight 

path perpendicular to the sketch plane. This feature forms the foundation of most 3D models in 

SolidWorks and is frequently used to create the primary geometry of a part. 

The Extrude Boss/Base adds material to a sketch to create a 3D solid. It is ideal for building blocks, 

plates, cylinders, and other basic shapes. To use the tool, you must first have a fully or partially 

defined 2D sketch, such as a rectangle, circle, polygon, or other closed-loop geometry. The result 

of the extrusion depends on the sketch's shape and the parameters you define, such as the extrusion 

depth and direction. 

 

Steps to Use the Extrude Boss/Base Tool 

1. Start by selecting a plane (e.g., Front, Top, or Right Plane) or a flat face of an existing part. 

2. Use sketch tools (like Rectangle, Circle, or Polygon) to draw a closed-loop 2D shape. 

3. Once the sketch is complete, click on Features > Extrude Boss/Base from the Command 

Manager, or select it from the right-click menu. 

4. A dynamic preview of the extrusion will appear in the graphics area. This helps you 

visualize the final shape before applying the feature. 



 

 

Tips  

 

• Closed Sketch Requirement: Ensure your sketch is a closed profile; open profiles 

cannot be extruded into a solid object. 

• Using Multiple Profiles: You can extrude multiple, non-overlapping closed profiles 

from a single sketch at the same time. 

• Adding Drafts: Use the draft angle to prepare parts for manufacturing, such as 

injection molding. 

• Reusing Sketches: Sketches can be reused for multiple extrusions by selecting them 

again from the Feature Manager Design Tree. 

 

 

Revolve Boss/Base 

The Revolve Boss/Base tool in SolidWorks is used to create 3D features by rotating a 2D sketch 

around a central axis. It is particularly useful for designing symmetrical, rounded, or rotational 

components such as shafts, pulleys, bowls, and spheres. This tool takes a 2D profile and "sweeps" 

it in a circular motion, producing a solid shape. 

The Revolve Boss/Base tool is designed to create features with radial symmetry by revolving a 

sketch about a chosen axis. The output is a 3D solid created by rotating the sketch around the 

specified axis. The angle of revolution determines how much of the shape is created. 

 

Steps to Use the Revolve Boss/Base Tool 

1. Select a plane (e.g., Front, Top, or Right Plane) or a flat face of an existing part. 

2. Use sketch tools (like Line, Arc, or Spline) to create the 2D profile you want to revolve. 



 
3. Add a centerline (construction geometry) to serve as the axis of revolution. 

 

 

 

4. Once the sketch is complete, click on Features > Revolve Boss/Base from the Command 

Manager, or access it via the right-click menu. 

 

 
5. A dynamic preview of the revolved shape will appear in the graphics area, allowing you to 

visualize the final result before applying the feature. 

 



6. Click OK or press Enter to complete the revolution, transforming your 2D sketch into a 3D 

revolved feature. 

 

 

 

3.3.2 Cut Features 

 

Cut features in SolidWorks are powerful tools that remove material from a 3D part, enabling the 

creation of complex geometries and hollowed sections. These features are essential for designing 

functional parts, such as those requiring holes, grooves, or cavities. 

 

Overview of Cut Features 

Cut features are similar to Boss/Base features but instead of adding material, they subtract it. 

They are applied to existing 3D models and rely on 2D sketches to define the shape and location 

of the material to be removed. 

 

Common types of cut features include: 

 

• Extruded Cut: Removes material along a straight path. 

• Revolve Cut: Removes material by revolving a sketch around an axis. 

Both methods rely on precise sketching and proper alignment with the part geometry to achieve 

accurate results. 

 

 

 



Extruded Cut 

The Extruded Cut tool removes material by extending a sketch along a linear path. It is one of 

the most frequently used tools for cutting holes, slots, and other shapes. 

 

Steps to Use the Extruded Cut Tool: 

 

1. Select a face or plane on the part to begin sketching. 

 

 
 

2. Draw the 2D profile of the shape you want to cut (e.g., a circle for a hole, a rectangle for 

a slot). 

 

 
3. Click Features > Extruded Cut from the Command Manager. 

 



 
 

4. Direction: Choose the direction of the cut (e.g., "Blind," "Through All," or "Up to Next"). 

 

 
 

5. Depth: Specify the distance the cut should extend. 

 

 
 



6. A preview of the cut will appear in the graphics area. 

 

 
 

7. Click OK to apply the cut. 

 

 

 

 

 

 

 

 

 

 



Example: Creating a Hole in a Block 

Create a 20mm diameter hole at the center point of a 40mm x 30mm block that is 22mm 

thick. 

 

 

 
 

Solution 

Create the 40mm x 30mm Block 

Step A: Select a Plane 

In the Feature Manager Design Tree (on the left side), select the Top Plane (or another preferred 

plane, such as Front Plane). 

 

Step B: Create a Rectangle Sketch 

1. Click on Sketch from the Command Manager and select Rectangle > Center Rectangle 

from the drop-down menu. 

2. Click on the origin (the center of the plane) to start the rectangle. 

3. Drag the rectangle outward and click again to complete it. 

 

Step C: Add Dimensions 

1. Activate the Smart Dimension tool from the Sketch toolbar. 

2. Click on one side of the rectangle and set its length to 40mm. 

3. Click on the adjacent side and set its width to 30mm. 



 

Step D: Extrude the Rectangle 

 

1. Click Features > Extruded Boss/Base in the Command Manager. 

2. Set the extrusion depth to a value of your choice (e.g., 10mm) in the Property Manager. 

3. Click OK to create the 3D block. 

 

Create the 20mm Diameter Hole 

Step A: Select the Top Face of the Block 

1. Rotate the part using the middle mouse button (scroll wheel) to view the top face. 

2. Click on the top face of the block to highlight it. 

3. Click Sketch from the Command Manager to start a new sketch on this face. 

 

Step B: Draw a Circle 

1. Select the Circle tool from the Sketch toolbar. 

2. Hover over the center of the top face, and a yellow dot will appear indicating the 

midpoint. This is the center of the rectangle. 

3. Click once to place the center of the circle, then drag outward and click again to define 

the circle's size. 

 

Step C: Add a Dimension 

1. Activate the Smart Dimension tool. 

2. Click on the circle and set its diameter to 20mm. 

 

Step D: Fully Define the Sketch 

Ensure the circle is fully defined (black in color). This should occur automatically because its 

center is at the midpoint of the rectangle. 

 

Step E: Create the Hole 

1. Click Features > Extruded Cut in the Command Manager. 

2. In the Property Manager, select Through All as the depth option to ensure the hole passes 

through the block. 

3. Click OK to apply the cut. 



 

3.3.3 Fillets and Chamfers 

In SolidWorks, Fillets and Chamfers are essential tools used to modify edges of 3D parts. They 

enhance the design's functionality, aesthetics, or manufacturability by rounding or beveling edges. 

 

Fillets: Rounding Edges 

A fillet is used to create a smooth, rounded transition between two adjacent surfaces or edges. 

Fillets are especially useful in improving part strength, reducing stress concentrations, and 

enhancing the overall appearance of a part. 

 

Steps to Create a Fillet 

1. In the Command Manager, go to Features > Fillet (or select the Fillet tool from the 

shortcut toolbar). 

 

 
 

2. Click on the edge or edges of the part that you want to round. Selected edges will 

highlight in blue. 

 
 

3. In the Property Manager, define the Fillet Radius (e.g., 5mm). This determines the size of 

the rounded edge. 



 

 

4. SolidWorks displays a yellow preview of the fillet to help you visualize the change. 

 

 
5. Click OK to confirm and apply the fillet. The rounded edge is now part of the geometry. 

 

 

 

 

 

 

 

 



Chamfers: Beveling Edges 

A chamfer creates a flat, angled surface along the edge of a part. Chamfers are often used to 

facilitate part assembly, eliminate sharp edges, or prepare parts for machining. 

 

Steps to Create a Chamfer 

1. In the Command Manager, go to Features > Chamfer (or select the Chamfer tool from the 

shortcut toolbar). 

 

 
 

2. Click on the edge or edges where the chamfer will be applied. Selected edges will 

highlight in blue. 

 

3. SolidWorks displays a yellow preview of the chamfer. Adjust parameters as needed. 

4. Click OK to confirm and apply the chamfer. 

 

 



3.4 Using Reference Geometry 

 

Reference geometry helps you create complex parts by providing additional construction 

elements. 

 

Planes 

Create additional planes at specific angles or distances from existing planes. 

Example: A plane at 45° is used to create an angled cut. 

Axes 

Define axes for use in revolve or circular pattern features. 

Points 

Add reference points to help locate specific positions in the part. 

Insert Screenshot: Show a part with additional planes and an axis used for a revolve. 

 

3.5 Design Intent and Feature Order 

 

Design intent is a fundamental principle in SolidWorks that ensures your part adapts seamlessly to 

changes while maintaining its functionality. The sequence in which you create features plays a 

crucial role in preserving design intent and avoiding potential issues. 

 

One key concept is parent-child relationships, where later features (children) rely on earlier 

features (parents). For example, if a child feature depends on a specific edge or face created by a 

parent feature, deleting or modifying the parent can lead to errors or broken references in the child 

features. This relationship emphasizes the importance of carefully planning the order of feature 

creation. 

 

To achieve robust designs, adhere to these best practices 

• Fully define your sketches before converting them into features. Undefined sketches can 

lead to unpredictable behavior when dimensions or constraints are modified. 

• Begin with base features, such as extrusions or revolves, to establish the fundamental shape 

of the part. Once the primary structure is complete, add refinement features like cuts, fillets, 

and chamfers to enhance detail and functionality. 



Example: Designing a Bracket as a Part 

Create a 20mm diameter hole at the center point of a 40mm x 30mm block with 22mm 

thickness. Make the upper corners rounded with a 5mm fillet each. The lower corners need 

to be chamfered 10 mm with a 45o angle.  

 

 

 

 

 

 

Solution 

Create the 40mm x 30mm Block 

Step A: Select a Plane 

In the Feature Manager Design Tree (on the left side), select the Top Plane (or another preferred 

plane, such as Front Plane). 

 

Step B: Create a Rectangle Sketch 

1. Click on Sketch from the Command Manager and select Rectangle > Center Rectangle 

from the drop-down menu. 

2. Click on the origin (the center of the plane) to start the rectangle. 

3. Drag the rectangle outward and click again to complete it. 



 

Step C: Add Dimensions 

1. Activate the Smart Dimension tool from the Sketch toolbar. 

2. Click on one side of the rectangle and set its length to 40mm. 

3. Click on the adjacent side and set its width to 30mm. 

 

Step D: Extrude the Rectangle 

 

1. Click Features > Extruded Boss/Base in the Command Manager. 

2. Set the extrusion depth to a value of your choice (e.g., 10mm) in the Property Manager. 

3. Click OK to create the 3D block. 

 

Create the 20mm Diameter Hole 

Step A: Select the Top Face of the Block 

1. Rotate the part using the middle mouse button (scroll wheel) to view the top face. 

2. Click on the top face of the block to highlight it. 

3. Click Sketch from the Command Manager to start a new sketch on this face. 

 

Step B: Draw a Circle 

1. Select the Circle tool from the Sketch toolbar. 

2. Hover over the center of the top face, and a yellow dot will appear indicating the 

midpoint. This is the center of the rectangle. 

3. Click once to place the center of the circle, then drag outward and click again to define 

the circle's size. 

 

Step C: Add a Dimension 

1. Activate the Smart Dimension tool. 

2. Click on the circle and set its diameter to 20mm. 

 

Step D: Fully Define the Sketch 

Ensure the circle is fully defined (black in color). This should occur automatically because its 

center is at the midpoint of the rectangle. 

Step E: Create the Hole 



1. Click Features > Extruded Cut in the Command Manager. 

2. In the Property Manager, select Through All as the depth option to ensure the hole passes 

through the block. 

3. Click OK to apply the cut. 

 

Apply Fillets to the Upper Corners 

Step A: Activate the Fillet Tool 

1. Go to Features > Fillet. 

2. Set the fillet radius to 5mm. 

 

Step B: Select the Edges 

Click the two upper corners of the block. The edges will round off. 

 

Step C: Confirm the Fillet 

Click OK to apply the fillets. 

 

Step D: Apply Chamfers to the Lower Corners 

Go to Features > Chamfer. 

 

Step E: Set the chamfer parameters to: 

Distance: 10mm 

Angle: 45° 

 

Step F: Select the Edges: 

Click the two lower corners of the block. The edges will bevel according to the specified 

dimensions. 

 

Confirm the Chamfer: 

Click OK to apply the chamfers. 



Chapter 3 Practice Questions 

 

 

Section 1: Multiple Choice Questions  

 

1. What is the primary purpose of features in SolidWorks? 

A. To add or remove material from a part 

B. To create 2D sketches 

C. To simulate mechanical assemblies 

D. To design layouts for technical drawings 

 

2. Which feature is used to create a 3D shape by revolving a sketch around an axis? 

A. Extruded Boss/Base 

B. Revolved Boss/Base 

C. Fillet 

D. Chamfer 

 

3. What happens when you delete a parent feature in a part? 

A. The child features become suppressed automatically 

B. The child features remain intact 

C. The child features break and may need to be repaired 

D. The entire part is deleted 

 

4. How do you create a beveled edge in SolidWorks? 

A. Using the Fillet tool 

B. Using the Chamfer tool 

C. Using the Offset Entities tool 

D. Using the Mirror Entities tool 



 

5. What does a fillet do to the edges of a part? 

A. It rounds them 

B. It sharpens them 

C. It adds material to them 

D. It removes material along the edges 

 

6. Which option is NOT required when performing an extruded cut? 

A. Selecting a sketch 

B. Choosing a direction or depth 

C. Specifying a rotation angle 

D. Setting the cut type (e.g., blind or through all) 

 

7. What are the key components of design intent in SolidWorks? 

A. Avoiding constraints and dimensions 

B. Ensuring adaptability to future changes 

C. Adding arbitrary relations to a sketch 

D. Creating parts without considering assemblies 

 

 

 

 

 

 

 

 

 

 



Section 2: Design Practice Questions 

 

1. Basic Block Design 

Design a 50mm x 40mm block with a thickness of 25mm. Add a 15mm diameter hole centered 

on the top face. Round the top edges with a 5mm fillet. 

 

2. Revolve a Part 

Create a semi-circle sketch with a diameter of 40mm on the Front Plane. Use the Revolve 

Boss/Base tool to create a full cylindrical part. Add a circular groove near the middle of the 

cylinder using a Revolve Cut feature. 

 

3. Chamfer and Fillet Exercise 

Design a rectangular block (60mm x 40mm x 30mm). Apply a 10mm chamfer to one corner on 

the top face. Add 7mm fillets to all remaining edges. 

 

4. Complex Part Creation 

Start with a 100mm x 50mm rectangle and extrude it to 20mm thickness. Add two circular holes, 

each with a 10mm diameter, 20mm apart and centered on the rectangle. Use the Chamfer tool to 

bevel all vertical edges with a 3mm distance at a 45° angle. 

 

5. Revolve and Combine Features 

Create a 2D sketch of a trapezoid (base: 40mm, top: 20mm, height: 30mm). Revolve this 

trapezoid around its vertical axis to create a conical shape. Add a 15mm diameter cylindrical cut 

through the center of the cone. 

 

 

 

 

 

 



Chapter 3 Answer Sheet 

 

1 A 

2 B 

3 C 

4 B 

5 A 

6 C 

7 B 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



CHAPTER 4 

ASSEMBLIES 
 

 

 

 

 

 

 

 



4.1 Introduction to Assemblies 

 

Assemblies are a fundamental aspect of SolidWorks, allowing users to combine individual 

components into a larger, functional system. They enable designers to visualize how parts fit and 

interact with one another, ensuring proper functionality before manufacturing. Whether creating 

simple mechanisms or intricate machines, assemblies provide a platform for integrating, 

validating, and refining designs. 

An assembly in SolidWorks is essentially a collection of parts or sub-assemblies arranged together. 

This process allows engineers to assess the fit and functionality of the design, check for potential 

issues such as interference, and simulate real-world motion. Assemblies are created using either 

the bottom-up approach, where pre-designed parts are added to the assembly, or the top-down 

approach, where parts are designed within the assembly context. These methods can be used 

independently or combined, depending on the complexity of the project. 

 

4.2 Creating Assemblies in SolidWorks 

 

Assemblies in SolidWorks provide a platform to combine individual components and simulate how 

they interact. This allows designers to ensure the fit, alignment, and functionality of parts before 

proceeding with manufacturing. Creating an assembly involves importing parts, arranging them in 

the desired positions, and applying constraints, called mates, to control their spatial relationships. 

The first component inserted into an assembly file is fixed in space by default. This part acts as the 

foundation, or reference, for all subsequent components. You can change its status to float if 

repositioning is needed. After the first part is fixed, additional components can be added to create 

the complete assembly. 

Each component in an assembly is essentially "free-floating" until constrained. By applying mates, 

you define relationships like alignment, rotation, or fixed distances between parts. This ensures 

that parts are positioned correctly relative to one another, mimicking real-world conditions. 

Advanced mates like gear mates or path mates allow for simulating mechanical motion, such as 

gears turning or components sliding along a defined path. 

In addition to adding and constraining components, assemblies offer tools for analysis, including 

interference and collision detection. These tools help identify design flaws and prevent costly 

manufacturing errors. Once the assembly is complete, features like exploded views, assembly 

configurations, and detailed drawings can further enhance communication and documentation of 

the design. 

 

 



Creating a New Assembly in SolidWorks 

Follow these steps to create a new assembly in SolidWorks: 

1. Start a New Assembly File 

• Open SolidWorks and click on File > New. 

• Select Assembly from the options and click OK. 

 

2. Insert the First Component 

• After starting the assembly file, the "Insert Component" dialog appears. 

• Browse for the first part you want to add (e.g., a base or reference component) 

and click Open. 

• Place the part in the workspace. This first part is fixed by default. 

 

3. Add Additional Components 

• Click on Insert Components from the toolbar or the Assembly tab. 

• Select the next part to add and position it near the first component in the 

workspace. 



 

4. Apply Mates to Define Relationships 

• Click on the Mate tool from the Assembly toolbar or Features tab. 

• Select faces, edges, or points of two parts to define how they interact. 

• Specify the type of mate (e.g., Coincident, Concentric, Tangent) in the Property 

Manager. 

• Click OK to apply the mate. 

 

 

5. Repeat for All Components 

• Continue adding components and applying mates until all parts are assembled. 

• Adjust or float parts as needed to finalize their positioning. 



 

6. Analyze the Assembly 

• Use Interference Detection to ensure no parts overlap. 

• Enable Collision Detection during movement to verify proper mechanical 

interactions. 

 

7. Save the Assembly 

• Once satisfied with the arrangement and functionality, click File > Save As and 

choose a location to save your assembly file with a descriptive name. 

 

 

 

 

 

 

 



4.3 Mates in Assemblies  

Mates in SolidWorks are essential tools that define how parts in an assembly relate to each other. 

They act as constraints, restricting or guiding the movement of components to ensure proper 

alignment, positioning, and behavior. Mates help simulate real-world interactions between 

components, allowing you to validate design functionality before production. Understanding the 

types of mates and their applications is critical to creating effective and functional assemblies. 

 

Types of Mates 

SolidWorks provides several categories of mates, each tailored to different design needs. These 

categories include Standard Mates, Advanced Mates, and Mechanical Mates. 

1. Standard Mates 

These are the most commonly used mates that establish basic relationships between parts. 

• Coincident Mate: Aligns two faces, edges, or points so they touch or overlap in the same 

plane. 

 
 

Example: Aligning a bolt's flat face with a washer's flat face. 

• Parallel Mate: Ensures two faces or edges remain parallel to each other, regardless of 

their distance. 

 



Example: Keeping two brackets aligned side by side. 

• Perpendicular Mate: Constrains two faces or edges to be at a 90° angle relative to each 

other. 

 
Example: Ensuring a vertical post stays perpendicular to a horizontal base. 

• Tangent Mate: Ensures a curved surface (e.g., a cylinder or sphere) touches another 

surface at a single point. 

 
Example: Positioning a roller against a guide track. 

• Distance Mate: Sets a fixed distance between two entities (e.g., faces, edges, or points). 

Example: Ensuring a gap between two plates. 

• Angle Mate: Defines an angular relationship between two components. 

Example: Positioning a ramp at a 30° incline relative to the ground. 

 



2. Advanced Mates 

Advanced mates are used for more specific or complex constraints. 

• Width Mate: Centers a component between two parallel faces or planes. 

Example: Placing a piston rod equidistant between the walls of a cylinder. 

• Path Mate: Constrains a component to follow a predefined path, such as a sketch or an 

edge. 

Example: Guiding a slider along a curved track. 

• Symmetric Mate: Keeps a part symmetrically positioned between two reference entities. 

Example: Centering a shaft between two supports. 

 

3. Mechanical Mates 

Mechanical mates simulate real-world mechanical interactions, making them invaluable for 

motion analysis. 

• Gear Mate: Simulates rotational motion between two gears with a specified gear ratio. 

Example: Ensuring one gear rotates twice as fast as another. 

• Cam Mate: Constrains a follower to remain in contact with a cam profile as it rotates. 

Example: Defining the motion of a camshaft and its follower. 

• Hinge Mate: Simulates a hinge, allowing rotation around a single axis. 

Example: Defining the motion of a door. 

• Rack and Pinion Mate: Simulates the interaction between a rack and a pinion gear to 

convert rotary motion to linear motion. 

Example: A rack sliding forward as the pinion rotates. 

 

Steps to Add Mates 

Adding mates in SolidWorks is a straightforward process. Follow these steps to ensure accurate 

and effective mating of components in an assembly: 

1. Activate the Mate Tool 

• Open your assembly and navigate to the Assembly Toolbar. 

• Click on the Mate tool to open the Mate Property Manager. 

 

 



2. Select Components to Mate 

• Click on the faces, edges, vertices, or points you want to mate. 

• The selected entities appear in the Mate Selections box within the Property 

Manager. 

 

3. Choose the Mate Type 

• From the Mate Type section, choose the desired type of mate (e.g., Coincident, 

Parallel, Tangent). 

• Preview lines and icons will indicate the result of the mate. 

 



4. Adjust Mate Parameters 

• For mates like Distance or Angle, specify the required values in the input fields. 

• Adjust mate alignment if necessary (e.g., flip alignment for coincident or parallel 

mates). 

5. Confirm the Mate 

• Click OK or the green checkmark to apply the mate. 

• The mated components will now be constrained according to the selected 

relationship. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



4.4 Analyzing Assemblies 

Analyzing assemblies in SolidWorks is a crucial step in validating your design. By using the built-

in analysis tools, you can identify potential issues, optimize performance, and ensure the assembly 

meets functional requirements. This section explores the tools available for evaluating assemblies 

in detail. 

 

1. Interference Detection 

Interference Detection is a tool that identifies overlapping geometry between components in an 

assembly. This is particularly useful in complex assemblies where tight tolerances are required or 

where multiple parts are assembled in close proximity. Overlapping parts can cause manufacturing 

errors or functionality issues, so detecting them early is vital. 

• Purpose: Identify and resolve unwanted overlaps between parts. 

• Accessing the Tool: Navigate to Evaluate then Interference Detection on the toolbar. 

• Procedure: 

▪ Select the components or subassemblies you want to evaluate. 

▪ The tool highlights areas where interference occurs, providing visual feedback. 

▪ You can choose to ignore certain interferences, such as those in fasteners or intended 

press fits. 

2. Collision Detection 

Collision Detection allows you to simulate the movement of parts in the assembly and check if 

any components collide during motion. This tool is essential for assemblies with moving parts, 

such as mechanisms, machines, or robotic systems. 

• Purpose: Identify and resolve collisions during part motion. 

• How to Enable: 

• Open the Move Component tool in the Assembly tab. 

 

• Check the Collision Detection option and specify the parts to monitor. 



 

• Features: 

• Real-time feedback as components move, showing where and when collisions 

occur. 

• You can simulate motion manually by dragging parts or using predefined mates to 

drive motion. 

 

3. Mass Properties 

The Mass Properties tool calculates the physical properties of the entire assembly or individual 

components, such as weight, center of gravity, and moments of inertia. This information is 

essential for structural, dynamic, and material-related analysis. 

• Purpose: Evaluate the physical characteristics of the assembly to ensure proper design. 

• Accessing the Tool: Go to Evaluate > Mass Properties. 

• Procedure: 

▪ The tool uses the materials assigned to each part to calculate properties. 

▪ The center of gravity is displayed graphically in the assembly view, helping you 

visualize weight distribution. 

• Features: 

▪ The ability to export mass property data for further analysis. 

▪ Modify material properties to see how changes affect the assembly’s mass or 

balance. 



4. Motion Analysis 

Motion Analysis is used to simulate the movement and interaction of parts within an assembly. It 

helps you understand how the assembly will behave under real-world conditions, including 

forces, constraints, and external influences. 

• Purpose: Test the functionality and motion of mechanical assemblies. 

• Accessing the Tool: Open the Motion Study tab at the bottom of the screen. 

• Procedure: 

▪ Add components like motors, springs, dampers, or gravity to the assembly. 

▪ Define mates and constraints to guide the motion. 

▪ Run the simulation to visualize and analyze the movement. 

• Features: 

▪ Generate animations to present the motion to stakeholders. 

▪ Use plots to measure variables like velocity, displacement, or force. 

 

4.5 Managing Assemblies 

 
Managing assemblies in SolidWorks is essential as designs grow in size and complexity. 

Assemblies often include dozens, hundreds, or even thousands of components, which can make 

navigating, modifying, and optimizing them challenging. SolidWorks provides a variety of tools 

and strategies to ensure efficient organization, quick modifications, and enhanced performance. 

This section covers the core methods for managing assemblies effectively. 

 
 
Assembly Tree (Feature Manager) 

 

The Assembly Tree, displayed in the Feature Manager Design Tree, is the central hub for 

organizing and interacting with the components and mates within an assembly. It lists all parts, 

subassemblies, and relationships in a hierarchical structure, allowing you to easily locate, group, 

or modify items. 

• Hierarchy and Grouping: The tree represents the structure of the assembly, showing 

how components and subassemblies are nested. Parts and subassemblies are displayed in 

order, with mates listed below them. You can use folders to group related components, 

such as fasteners or similar subassemblies, for better organization. 

 



 

• Editing Components: 

▪ Right-click on a component to edit its properties, suppress it, or hide/show it 

within the assembly. 

▪ Drag and drop parts to reorganize them in the tree or move them to different 

subassemblies. 

• Tips for Efficiency: 

o Rename components in the tree to reflect their function (e.g., “Left Bracket” 

instead of “Part1”). 

o Use the search bar to quickly locate components in large assemblies. 

Tips for Efficiency  

 

• Rename components in the tree to reflect their function (e.g., “Left Bracket” instead of 

“Part1”). 

• Use the search bar to quickly locate components in large assemblies. 

 
 
 

4.6 Practical Example: Creating a Simple Assembly 

 

Understanding how to create a simple assembly is a critical step in mastering SolidWorks. 

Assemblies are at the heart of mechanical design, allowing you to bring together individual parts 

and define their relationships to simulate real-world functionality. In this section, we will walk 

through the process of creating a simple assembly consisting of a rectangular base, a cylindrical 

rod, and a mounting plate. This example introduces basic assembly tools and concepts, including 

inserting components, adding mates, and refining the assembly for proper alignment and 

movement. 

Objective 

Create an assembly where a cylindrical rod with 10 mm radius and 100 mm long is inserted 

vertically into a rectangular 25 mm thickness base that is 100 mm x 60 mm with a central hole that 

is 20 mm in diameter, and a mounting plate is attached on top of the rod. This assembly will 

demonstrate the use of component insertion, standard mates, and adjustments for design intent. 

 



Steps to Create the Assembly 

Step 1: Preparing the Parts 

 

Before creating an assembly, you need individual part files for the base, cylindrical rod, and 

mounting plate. Each part should be saved separately in SolidWorks. Ensure the dimensions are 

compatible: 

• The base has a rectangular footprint of 100 mm x 60 mm with a 20 mm diameter hole at 

its center. 

 

• The cylindrical rod is 20 mm in diameter and 100 mm in height. 

 

• The mounting plate is 40 mm x 40 mm with a central hole of 20 mm in diameter. 



 

Step 2: Starting a New Assembly 

1. Open SolidWorks and click File > New > Assembly. 

2. In the Begin Assembly dialog box, click Insert Components. 

3. Browse for the base part file and insert it into the assembly. The first part is fixed 

automatically, serving as the foundation. 

 

Step 3: Inserting Additional Components 

1. Click Insert Components again from the Assembly toolbar. 

2. Select the cylindrical rod file and place it near the base in the graphics area. 

3. Repeat the process to add the mounting plate. 

 

 

 



Step 4: Applying Mates 

 

Mates define how components relate to each other within the assembly. For this example, you will 

align the cylindrical rod with the hole in the base and position the mounting plate on top of the 

rod. 

1. Mate the Rod to the Base: 

• Click the Mate tool in the Assembly toolbar. 

• Select the cylindrical face of the rod and the cylindrical face of the hole in the 

base. 

 

• Choose Concentric Mate from the Property Manager. This ensures the rod is 

aligned with the hole. 

• Select the bottom face of the rod and the top face of the base. Apply a Coincident 

Mate to make them flush. 

 

 

 



2. Mate the Mounting Plate to the Rod: 

• Select the cylindrical face of the hole in the mounting plate and the outer 

cylindrical face of the rod. Apply a Concentric Mate. 

• Mate the bottom face of the mounting plate to the top face of the rod using a 

Coincident Mate. 

 

Step 5: Adjusting and Verifying the Assembly 

After adding mates, verify the assembly for proper alignment and functionality: 

• Check Alignment: Rotate the view and inspect if all parts are properly aligned. 

• Test Movement: If any mates allow movement (e.g., rotational freedom), test the 

assembly by dragging the parts to ensure they move as intended. 

 

Step 6: Saving the Assembly 

Once the assembly is complete, save it: 

1. Click File > Save As. 

2. Name the assembly and choose a location. 

3. SolidWorks will automatically save references to the individual part files. 

 
 
 
 
 
 



Chapter 4 Practice Questions 

 

 

Section 1: Multiple Choice Questions  

 

1. What is the primary function of the Mate tool in SolidWorks assemblies? 

A. To create new parts in the assembly 

B. To define spatial and functional relationships between parts 

C. To adjust the dimensions of individual parts 

D. To apply materials to components 

 

2. Which mate ensures two faces are flush with each other? 

A. Parallel Mate 

B. Coincident Mate 

C. Perpendicular Mate 

D. Tangent Mate 

 

3. What is the purpose of Interference Detection in assemblies? 

A. To create mates between parts 

B. To identify overlapping geometry between components 

C. To measure the total weight of the assembly 

D. To adjust the transparency of parts 

 

4. How do you access Large Assembly Mode in SolidWorks? 

A. Assembly Toolbar > Large Assembly 

B. Insert > Components > Large Assembly 

C. Options > System Options > Assemblies 

D. Evaluate > Performance Tools > Large Assembly 



 

5. What type of mate allows a cylindrical component to follow a curved path? 

A. Width Mate 

B. Path Mate 

C. Cam Mate 

D. Gear Mate 

 

6. Which of the following best describes an Exploded View? 

A. A detailed representation of an individual part 

B. A simplified version of an assembly for performance optimization 

C. A view that shows the disassembled state of an assembly 

D. A simulation of motion between components 

 

 

Section 2: Design Practice Questions 

 

1. Design an Assembly with Mates: 

Create an assembly consisting of a rectangular base (100mm x 50mm), a cylindrical rod 

(diameter 20mm, height 80mm), and a spherical cap (diameter 40mm) positioned on top of the 

rod. Use mates to ensure proper alignment and attachment of all components. Save the assembly 

file. 

 

2. Interference Check in an Assembly: 

Design an assembly with two rectangular blocks (100mm x 50mm x 20mm) and a cylindrical rod 

(diameter 20mm, height 50mm). Place the rod through a hole in one block and check for 

interference with the second block. Use the Interference Detection tool to verify and correct any 

issues. 

 

 

 



3. Exploded View Creation: 

Create an assembly of a mechanical hinge with two rectangular plates (60mm x 30mm) 

connected by a pin (diameter 10mm, length 40mm). Use the Exploded View tool to show how 

the hinge components are assembled. 

 

4. Gear Assembly with Mechanical Mate: 

Design an assembly with two gears (diameters 40mm and 60mm) and use a Gear Mate to 

simulate their rotational interaction. Test the motion of the gears to ensure they function 

correctly. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 4 Answer Sheet 

 

1 B 

2 B 

3 B 

4 C 

5 B 

6 C 

  

 

 

 
 
 

 

 

 

 

 

 

 

 



CHAPTER 5  

PROJECTION 

VIEWS 
 

 

 

 

 

 

 



5.1 Introduction to Projection Views 

 

Projection views are a cornerstone of engineering design and technical drawings, serving as a 

bridge between three-dimensional (3D) models and two-dimensional (2D) representations. These 

views allow engineers, manufacturers, and other stakeholders to visualize and interpret a 3D object 

accurately on a flat surface. By breaking down complex geometries into clear, flat representations, 

projection views ensure that every detail of a design is captured and communicated effectively. 

In practice, projection views enable manufacturers to understand the dimensions, features, and 

spatial relationships of a part or assembly without ambiguity. This is critical for tasks like 

machining, assembly, quality control, and inspection. Without precise projection views, 

misinterpretations could lead to errors in production or failures in functionality. 

SolidWorks offers a suite of tools to create and manage projection views seamlessly. These tools 

are designed to ensure that engineers can generate drawings that conform to industry standards, 

such as ISO or ANSI. SolidWorks automates much of the process, enabling users to quickly create 

multiple views from a single 3D model, maintain alignment between views, and update drawings 

dynamically when the model changes. 

 

The Role of Projection Views in Design Documentation 

Projection views play a pivotal role in documenting both parts and assemblies. They allow designs 

to move from the virtual environment of CAD software into the real world, where they can be 

manufactured and assembled. By providing detailed and accurate representations, projection views 

help ensure: 

 

1. Manufacturability: Precise views highlight all critical dimensions and tolerances, 

ensuring parts can be machined or molded to exact specifications. 

2. Inspectability: Projection views make it possible for quality control teams to measure and 

verify dimensions against the design intent. 

3. Communication: Engineers, machinists, and assemblers can easily interpret the design, 

regardless of their familiarity with the 3D model. 

In this chapter, we will explore the various types of projection views, their specific applications, 

and the step-by-step process of creating them using SolidWorks. This foundation is essential for 

mastering technical drawings and producing professional-grade documentation for engineering 

designs. 

 

 

 



5.2 Types of Projection Views 

Projection views are essential tools for representing 3D objects on 2D planes, allowing for clear 

and precise communication of design intent. Each type of projection view serves a specific 

purpose, helping to convey different aspects of an object’s geometry and features. In SolidWorks, 

users can create these views with ease, ensuring their technical drawings meet industry standards. 

Below are detailed descriptions of the main types of projection views, their applications, and 

examples. 

 

5.2.1 Orthographic Projection 

 

Orthographic projection is the most widely used method for engineering drawings. It involves 

projecting an object’s features onto a 2D plane to create multiple aligned views, typically including 

the front, top, and side views. These views are drawn without perspective distortion, ensuring 

accurate dimensions and spatial relationships. 

Orthographic projections are ideal for documenting an object’s precise geometry because each 

view isolates one side of the part. For example, the front view displays the height and width, while 

the top view reveals the width and depth. 

 

Purpose: 

• To communicate accurate dimensions, shapes, and spatial relationships between features. 

• To provide machinists and manufacturers with unambiguous details about the part's 

geometry. 

Example: 

Imagine a cube. The orthographic projection would display its front view (a square), top view 

(another square), and side view (also a square), all aligned with one another. Each view represents 

the cube’s specific dimensions and relationships without distortion. 

 



5.2.2 Isometric Views 

 

An isometric view offers a pseudo-3D representation of a part by positioning it at an angle where 

the three principal axes (X, Y, and Z) are equally inclined, typically 120° apart. Unlike 

orthographic views, isometric views add a sense of depth, making them highly effective for 

visualizing the overall shape and design of an object. 

Purpose: 

• To provide a comprehensive 3D perspective of the object. 

• To help non-technical viewers, such as clients or stakeholders, better understand the 

design. 

 

5.2.3 Section Views 

 

Section views are invaluable for revealing interior features of an object that are hidden in standard 

orthographic or isometric views. By cutting through the object along a predefined plane, section 

views expose internal details, such as cavities, holes, or structural reinforcements, that are 

otherwise invisible. 

Purpose: 

• To provide clarity about hidden or internal features of a part or assembly. 

• To ensure that internal structures are accurately communicated in technical drawings. 

 

Example: 

Consider a gear with internal spokes and a hollow center. A section view can slice through the 

middle of the gear, displaying the spoke pattern and the cavity’s dimensions, making it easier to 

understand the internal design. 

 

 



5.2.4 Auxiliary Views 

 

Auxiliary views are used to accurately depict inclined or slanted surfaces that are not clearly visible 

in standard orthographic projections. By projecting the view perpendicular to the inclined surface, 

auxiliary views capture the true dimensions and shape of the feature. 

 

Purpose: 

• To clarify the geometry of non-standard angles or slanted surfaces. 

• To provide accurate dimensions for features that are distorted in other views. 

Example: 

Imagine a ramp structure with an inclined surface. While the standard orthographic views may not 

show the ramp’s true shape or angle, an auxiliary view can be created to focus on the inclined 

plane, providing its precise dimensions and geometry. 

 

 

 

5.2.5 Detail Views 

 

Detail views magnify a specific area of a drawing to provide additional clarity for small or intricate 

features. These views are typically used when certain aspects of a part are too small to be properly 

understood at the scale of the primary views. 

 

 

Purpose: 



• To focus on critical features, such as small holes, threads, or fillets, without overcrowding 

the drawing. 

• To enhance understanding of intricate areas that require additional attention. 

Example: 

Suppose a part has a small fillet radius in one corner. A detail view can enlarge this corner, showing 

the fillet’s exact dimensions and shape, ensuring manufacturers understand how to produce the 

feature accurately. 

 

 

 

 

5.3 Creating Projection Views in SolidWorks 

SolidWorks streamlines the process of creating projection views from a 3D model, enabling users 

to document their designs efficiently and accurately. Projection views are essential for 

communicating design intent, as they represent the geometry, dimensions, and spatial relationships 

of a model in a format suitable for manufacturing and inspection. This section provides an in-depth 

explanation of how to create projection views in SolidWorks and their significance in engineering 

drawings. 

 

Overview of the Process 

To create projection views in SolidWorks, the workflow begins with a completed 3D model, which 

is then inserted into a drawing file. From there, you can create various types of views, such as 

orthographic, isometric, section, auxiliary, and detail views, each serving a specific purpose. 

SolidWorks automates much of this process while offering customization options to meet specific 

documentation requirements. 

 

 

Steps to Create Projection Views in SolidWorks 



1. Create a Drawing File 

• Launch SolidWorks and open your completed 3D model. 

• Go to the top menu and click File > New > Drawing. 

 

• Select a drawing template that matches your required sheet size, format, and orientation. 

Templates can be customized to align with company standards, such as A4 landscape or 

A3 portrait. 

 

 

2. Insert the 3D Model 

• Use the Insert > Model View command from the menu or drag and drop the 3D model 

into the drawing sheet. 



 

• The model appears as a primary view, typically the front view, which acts as the parent 

for creating other projection views. 

 

3. Create Orthographic Views 

• Open the View Palette from the Task Pane or Drawing toolbar. 



 

• Select standard views, such as Front, Top, and Right (or Left), to represent the object 

from multiple angles. 

• Drag and place these views onto the drawing sheet. SolidWorks ensures proper alignment 

of these views, maintaining consistency and clarity. 

 

• Adjust the spacing between views for readability. 

4. Generate an Isometric View 

• From the View Palette, select the Isometric View option. 

 



• Drag the isometric view onto the drawing sheet to provide a pseudo-3D perspective of the 

object. 

• Position the view for optimal visibility, usually near the upper-right corner of the sheet. 

5. Add Section Views 

• Use the Section View tool, available in the Drawing toolbar or under the Insert > 

Drawing View menu. 

 

• Define a cutting plane by selecting an edge or face in an existing view and drawing a line 

to indicate the cut. 

 

• Place the section view on the drawing sheet, showing internal features such as holes, 

cavities, or assemblies. 

 



• Annotate the section view with hatch patterns to differentiate between cut surfaces and 

remaining material. 

 

6. Generate Auxiliary Views 

• Select the Auxiliary View tool from the Drawing toolbar. 

 

• Identify an inclined surface in one of the standard views to serve as the basis for the 

auxiliary view. 

• Place the resulting auxiliary view on the sheet, perpendicular to the inclined surface, to 

capture its true dimensions and shape. 

7. Create Detail Views 

• Use the Detail View tool to focus on small or intricate features of the design. 

 

• Draw a circular or rectangular boundary around the area of interest in an existing view. 



 

• Drag and place the detail view onto the sheet, magnified for better understanding. 

 

• Label the detail view with a letter or number, referencing it back to the original view for 

clarity. 

 

 

 

 

 

 

 



5.4 Practical Applications of Projection Views 

Projection views are integral to engineering and manufacturing processes, serving as the 

cornerstone for communicating design intent effectively. By accurately representing 3D objects on 

2D planes, projection views provide critical information that bridges the gap between conceptual 

designs and real-world implementation. This section elaborates on how projection views are 

utilized in various practical applications, highlighting their importance in manufacturing, quality 

control, assembly, and technical documentation. 

 

1. Manufacturing 

Projection views play a vital role in manufacturing by providing machinists and fabricators with 

the precise information needed to create parts. They include dimensions, tolerances, and geometric 

details that ensure components are machined or fabricated to exact specifications. 

• Dimensions and Tolerances: Orthographic views, combined with annotations, convey 

critical measurements such as lengths, diameters, and angles. Tolerances are specified to 

define acceptable deviations, ensuring parts function as intended. 

• Material Indications: Section views often include hatch patterns to differentiate between 

materials, enabling machinists to select the correct stock material. 

• Ease of Interpretation: Isometric and auxiliary views can offer additional clarity, reducing 

the risk of misinterpretation and errors during the manufacturing process. 

 

Figure 16: Engineering Part. 

2. Quality Control 

Projection views are essential for verifying that manufactured components meet design 

specifications. Quality control (QC) teams rely on these views to measure and inspect parts, 

ensuring they conform to the original design intent. 



• Inspection Standards: QC personnel use the dimensions and tolerances from orthographic 

views to verify critical features using tools like calipers, micrometers, or coordinate 

measuring machines (CMM). 

• Internal Features: Section views reveal hidden internal geometries, such as cavities or 

threads, allowing inspectors to assess these elements without damaging the part. 

• Reference for Comparison: Projection views serve as a baseline for comparing the 

manufactured part with the design, highlighting any deviations or defects. 

3. Assembly Instructions 

Projection views provide clear and detailed instructions for assembling products, especially when 

dealing with intricate or multi-component assemblies. They ensure that components are assembled 

correctly, reducing errors and improving efficiency. 

• Exploded Views: Used in assembly drawings to show how parts fit together, offering a 

clear roadmap for workers during the assembly process. 

• Alignment Guidance: Auxiliary views help illustrate proper alignment for components 

with inclined or non-standard surfaces. 

• Assembly Order: Detailed annotations and callouts in projection views guide the sequence 

of assembly, ensuring that critical steps are not overlooked. 

 

Figure 17: Engine Assembly Design. 

4. Technical Documentation 

Projection views are the backbone of technical documentation, serving as a standardized means of 

communication between designers, engineers, manufacturers, and clients. They ensure that all 

stakeholders have a common understanding of the design. 

• Consistency: Standardized projection views (e.g., orthographic and isometric) ensure that 

documentation adheres to industry norms such as ASME Y14.5 or ISO 128. 

• Collaboration: Engineers and designers can exchange detailed technical drawings with 

clients or manufacturers, facilitating seamless collaboration. 



• Design Revision Tracking: Projection views document design changes over time, creating 

a record of revisions that can be referenced during production or maintenance. 

 

Key Benefits of Projection Views in Practical Applications 

1. Clarity: Projection views eliminate ambiguity, ensuring that everyone involved in the 

project understands the design intent. 

2. Accuracy: By conveying precise dimensions and tolerances, projection views minimize 

errors during manufacturing and assembly. 

3. Efficiency: Clear documentation reduces the time spent on interpretation, inspection, and 

troubleshooting. 

4. Standardization: Following industry standards ensures compatibility across different 

teams, tools, and workflows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



5.5 Practical Example: Documenting a Mechanical Part 

Projection views are integral to engineering and manufacturing processes, serving as the 

cornerstone for communicating design intent effectively. By accurately representing 3D objects on 

2D planes, projection views provide critical information that bridges the gap between conceptual 

designs and real-world implementation. This section elaborates on how projection views are 

utilized in various practical applications, highlighting their importance in manufacturing, quality 

control, assembly, and technical documentation. 

 

Objective 

The goal is to create a detailed drawing of a bracket with the following features: 

• Base Dimensions: 100mm x 50mm. 

• Holes: Two circular holes with a diameter of 10mm, each located 20mm from the 

respective edges. 

• Fillet: A 5mm fillet applied to all four corners of the bracket. 

 

The drawing will include multiple views, annotations, and proper formatting to ensure clarity 

and usability. 

 

 

 

 

 

Steps to Create the Drawing 



1. Open the 3D Model of the Bracket 

• Begin by designing the 3D model of the bracket in SolidWorks. Ensure the part is fully 

defined with all required features, including the fillet and holes. Save the model before 

proceeding. 

2. Create a New Drawing File 

• Open SolidWorks and click File > New > Drawing. 

• Select an appropriate drawing template based on the desired sheet size (e.g., A4 or 

ANSI A). 

• Set the orientation (landscape or portrait) to best fit the views and dimensions of the 

bracket. 

3. Insert the Model into the Drawing 

• Use the Insert Model View tool from the Drawing toolbar or drag the bracket model 

into the drawing sheet. 

• Choose the Front View as the base view and place it in the center of the sheet. 

 

4. Add Orthographic Views 

• From the View Palette, select the Top View and position it above the front view. 

• Add the Side View and align it to the right of the front view. Ensure proper alignment 

between these orthographic views to maintain clarity and consistency. 

5. Generate an Isometric View 

• Select the Isometric View option in the View Palette. 

• Place the isometric view in the upper-right corner of the drawing sheet to provide a 3D 

representation of the bracket. This view helps visualize the overall shape and features 

of the part. 

6. Create a Section View 

• Use the Section View tool to reveal internal details of the bracket. 

• Define a cutting plane (e.g., through the center of the bracket) and place the resulting 

section view below the front view. This will display the thickness and hole locations 

clearly. 



 

7. Annotate the Drawing 

• Use the Smart Dimension tool to add the following annotations: 

▪ Base Dimensions: Add dimensions for the 100mm x 50mm rectangle. 

▪ Hole Locations: Dimension the two holes, specifying their diameters 

(10mm) and distances (20mm from the edges). 

▪ Fillet Radius: Annotate the 5mm fillets on all corners. 

• Add center marks and centerlines for the holes to enhance clarity. 

• Include any necessary tolerances or notes, such as material specifications or surface 

finish requirements. 



 

8. Format the Drawing 

• Add a title block that includes the part name, drawing number, scale, date, and drafter's 

initials. 

• Ensure the views and annotations are properly spaced to avoid clutter. 

9. Save and Export the Drawing 

• Save the completed drawing file in SolidWorks format (*.slddrw) for future edits. 

• Export the drawing as a PDF by clicking File > Save As > PDF. This format is widely 

used for sharing and printing. 

 

 

 

 

 

 

 



The final drawing will include: 

• Front, Top, and Side Views (orthographic projection) to communicate precise 

dimensions and spatial relationships. 

• Isometric View for an intuitive 3D representation. 

• Section View to reveal hidden internal features, such as the hole depth. 

• Annotations that provide all critical information for manufacturing and quality control. 

 

 

 

 

 

 

 



Chapter 5 Practice Questions 

 

 

Section 1: Multiple Choice Questions  

 

1. What is the primary purpose of projection views in engineering drawings? 

A. To add color to 3D models 

B. To represent 3D objects on a 2D plane 

C. To make designs look artistic 

D. To remove unnecessary dimensions 

 

2. Which type of projection view shows an object’s front, top, and side without perspective 

distortion? 

A. Isometric View 

B. Section View 

C. Orthographic Projection 

D. Auxiliary View 

 

3. In an isometric view, how are the axes typically inclined? 

A. 90° apart 

B. 120° apart 

C. 180° apart 

D. 60° apart 

 

4. What is the main purpose of section views? 

A. To show a 3D perspective of the object 

B. To display the object's hidden interior details 

C. To enlarge small features for clarity 

D. To represent inclined surfaces accurately 

 

5. Which tool in SolidWorks is used to create a detail view? 

A. Section View 

B. Detail View 



C. Auxiliary View 

D. Isometric View 

 

6. What type of projection view is commonly used to represent slanted surfaces? 

A. Orthographic Projection 

B. Auxiliary View 

C. Section View 

D. Detail View 

 

7. When generating an orthographic projection in SolidWorks, which views are typically 

included? 

A. Top, Isometric, and Section 

B. Front, Top, and Side 

C. Section, Detail, and Auxiliary 

D. Front, Side, and Detail 

 

8. Why are detail views important in engineering drawings? 

A. To highlight large features 

B. To provide a 3D perspective 

C. To magnify small or intricate areas 

D. To show inclined surfaces 

 

 

 

 

 

 

 

 

 

 

 



Section 2: Design Practice Questions 

 

1. Create an Orthographic Projection 

Design a drawing of a mechanical component (e.g., a bracket, gear, or block) in 

SolidWorks. Include front, top, and side views in your drawing file. Ensure proper 

alignment between the views. 

 

2. Generate a Section View 

Design a hollow cylinder in SolidWorks. Create a section view that reveals the interior 

features, such as thickness and holes. Annotate all critical dimensions in the section view. 

 

3. Add Detail and Auxiliary Views 

Design a slanted block with small holes on an inclined surface. Create an auxiliary view to 

show the slanted surface accurately. Then, add a detail view to magnify one of the holes 

for clarity. 

 

4. Document an Isometric View 

Create an isometric view of a part with multiple features (e.g., fillets, holes, and cuts). Place 

it on the drawing sheet alongside orthographic views. Ensure annotations are clear and 

properly scaled. 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 5 Answer Sheet 

 

1 B 

2 C 

3 B 

4 B 

5 B 

6 B 

7 B 

8 C 

  

 

 

 
 

 

 

 

 

 

 


